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บทที่ 1 

บทนำ 

 

1.1 ที่มาและความสำคัญ 
 วัสดุมีความสำคัญอย่างยิ่งในการพัฒนาและเป็นสิ่งที่บ่งบอกถึงวิวัฒนาการของมนุษย์ โดยมี
มาตั้งแต่ยุคแรกเริ่มจนถึงปัจจุบัน มนุษย์เริ่มรู้จักนำวัสดุหรือวัตถุดิบตามธรรมชาติมาประยุกต์ในการ
ดำเนินชีวิตและพัฒนาวัสดุให้ตรงต่อความต้องการในชีวิตมากข้ึน โดยการนำวัสดุมากกว่าสองประเภท
มาผสมรวมกัน โลหะ พอลิเมอร์ เซลามิก โดยกรรมวิธีการต่างๆ เรียกว่า วัสดุเชิงประกอบ จนได้วัสดุ
ประเภทใหม่ขึ้นมาซึ่งคุณสมบัติเฉพาะตัวของวัสดุที่ได้มานั้นจะเปลี่ยนแปลงไปในทางที่ดีขึ้นหรือ
แตกต่างไปจากเดิม โดยยุคเริ่มแรกมนุษย์ได้นำฟางข้าวผสมกับดินเหนียว ซึ่งเส้นฟางข้าวจะช่วยให้ดิน
เหนียวมีความแข็งแรงมากขึ้น จนสามารถใช้ก่อซ้อนกันขึ้นเป็นผนัง กำแพงหรือบ้านดินเพ่ือสร้างเป็น
ที่กำบังภัยได ้
 ต่อมาในกลางคริสต์ศตวรรษที่ 20 เป็นยุคที่ความรู้ความก้าวหน้าทางวิทยาศาสตร์และ
เทคโนโลยีเริ่มเข้ามามีบทบาทต่อการพัฒนา เนื่องจากความต้องการวัสดุที่มีความแข็งแรงและขึ้นรูป
ให้มีรูปร่างซับซ้อนได้ จึงกลายเป็นแรงผลักดันให้เกิดการนำเส้นใยแก้วที่มีความแข็งแรงสูงมาเสริมแรง
ให้กับเรซินพอลิเมอร์ หรือที่เราเรียกกันว่า ไฟเบอร์กลาสส์ ให้เกิดเป็นวัสดุเชิงประกอบที่ทนต่อแรง
กระทำ โดยใช้เป็นส่วนประกอบของชิ้นส่วนที่ต้องการความแข็งแรง เช่น ตัวเรือ รวมไปถึงชิ้นส่วน
ต่างๆ ในเครื่องบินด้วย ในเวลาเดียวกันนั้นก็เริ่มมีการพัฒนาเทคโนโลยีของยางขึ้น โดยใช้การบ่มยาง
ธรรมชาติกับกำมะถัน เพ่ือเสริมยางที่มีสมบัติยืดหยุ่น นอกจากนี้การนำผงถ่านดำและเส้นใยอ่ืนๆ มา
เสริมแรงให้กับเมทริกยางจะเป็นการเพิ่มความแข็งแรงของยาง และได้วัสดุเชิงประกอบชนิดใหม่ข้ึน ที่
มีความแข็งแรงและทนทานต่อการใช้งานได้มากขึ้น จึงสามารถนำมาใช้เป็นยางล้อรถยนต์และ
เครื่องบินได้  ต่อมาจนถึงในปัจจุบันวัสดุเชิงประกอบได้พัฒนาและมีความต้องการมากขึ้นเรื่อยๆใน
ทุกๆด้าน วิศวกรเครื่องกลพยายามค้นหาวัสดุที่ทนอุณหภูมิสูงมากขึ้นเพ่ือนำไปสร้างยานอวกาศที่มี
ประสิทธิภาพสูงยิ่งขึ้น โดยใช้หลักของวัสดุเชิงประกอบ เช่น ซิลิกาและเคลือบผิวด้วยแก้วโบโรซิลิเกต
ผสมซิลิคอนโบไรค์ นำมาทำเป็นฉนวนความร้อนที่ทนต่ออุณภูมิสูงประมาณ 650-1,200 องศา
เซลเซียส ใช้ในผิวหน้าละด้านข้างของส่วนล่างของตัวยาน รวมทั้งบางจุดของส่วนหาง เป็นต้น จะเห็น
ได้ว่าภายในเวลาเพียงไม่ถึงหนึ่งศตวรรษ วัสดุเชิงประกอบก้าวเข้ามาเป็นวัสดุที่มีบทบาทอย่างมาก
ด้านวัสดุศาสตร์โดยเฉพาะอย่างยิ่งช่วงหลังปีคริสต์ศักราช 1970 ที่พัฒนาเทคโนโลยีเกี่ยวกับวัสดุเชิง
ประกอบเป็นไปอย่างก้าวกระโดด  
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 มหาลัยวิทยาลัยเทคโนโลยีราชมงคลพระนคร คณะวิศวกรรมศาสตร์ สาขาวิศวกรรม 
เครื่องกล มีการเรียนการสอนวิชาการประลองทางวิศวกรรมเครื่องกลซึ่งภายในสาขาวิชา วิศวกรรมยัง
ไม่มีเครื่องผสมผงวัสดุแบบวีเบลนเดอร์ ที่ใช้ในการประกอบ การเรียนการสอน เป็นสาเหตุให้ผู้จัดทำ
โครงงาน มีแนวคิดออกแบบเครื่องผสมผงวัสดุแบบ วีเบลนเดอร์และ สามารถใช้ทฤษฎีของหลัก
วิศวกรรมศาสตร์ในระดับปริญญาตรีมาประยุกต์ใช้ได้ 

 
1.2  วัตถุประสงค์ของโครงงาน 
 1.2.1 เพ่ือศึกษาวัสดุเชิงประกอบด้วยเครื่องผสมผงวัสดุแบบวีเบลนเดอร์ 
 1.2.2 เพ่ือศึกษาการทำงานเครื่องผสมผงวัสดุแบบวีเบลนเดอร์ 
 1.2.3 เพ่ือออกแบบและสร้างเครื่องผสมผงวัสดุแบบวีเบลนเดอร์ 

 
1.3  ขอบเขตของโครงงาน 
 1.3.1 ความเร็วรอบที่ใช้ในการผสมผงวัสดุไม่เกิน 50 รอบ/นาที 
 1.3.2 ภาชนะท่ีใช้บรรจุผงวัสดุเป็นสแตนเลส มีอยู่สองขนาดคือ 1 กิโลกรัม และ 2 กิโลกรัม 
 1.3.3 สารที่ใช้ในการผสมเป็นชนิดผงขนาดไมโครเท่านั้น 
 1.3.4 ขนาดของตัวเครื่องเป็นขนาดที่ใช้ในแล็ปทดลองของงานวิจัย 

 
1.4  ประโยชน์ที่คาดว่าจะได้รับ 
 1.4.1 ไดท้ราบถึงหลักการทำงานเครื่องผสมผงวัสดุแบบวีเบลนเดอร์ 
 1.4.2 ได้ออกแบบและสร้างเครื่องผสมผงวัสดุแบบวีเบลนเดอร์ 
 1.4.3 ได้เครื่องผสมผงวัสดุแบบวีเบลนเดอร์สำหรับใช้ในห้องปฎิบัติการ 
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บทที่ 2 
 

ทฤษฎีที่เกี่ยวข้อง 
 

ในโครงงานนี้ทำการศึกษาค้นคว้าออกแบบและสร้างเครื่องผสมผงวัสดุ แบบวีเบลนเดอร์ 
เพ่ือให้การออกแบบและสร้างบรรลุจุดประสงค์ที่วางไว้ ผู้จัดทำจึงได้กำหนดเนื้อหาของทฤษฎีและ
หลักการต่างๆที่เก่ียวข้องกับการออกแบบและสร้าง ดังนี้ 

 
2.1  วัสดุเชิงประกอบ (Composite Material) [1] 

วัสดุเชิงประกอบ หรือวัสดุคอมโพสิต (Composite materials) อาจหมายถึง วัสดุที่เกิดจาก
การรวมตัวของวัสดุมากกว่าหนึ่งชนิดขึ้นไปแล้วทำให้สมบัติของวัสดุรวมดีขึ้น สำหรับความหมายเชิง
วิศวกรรมของวัสดุเชิงประกอบ หมายถึง วัสดุที่ประกอบขึ้นจากวัสดุที่มีสมบัติแตกต่างกันตั้งแต่ 2 
ชนิดขึ้นไปโดยไม่เกิดการรวมตัวเป็นเนื้อเดียวกัน ทำให้สมบัติของวัสดุเชิงประกอบที่เกิดขึ้นมีสมบัติ
ร่วมกันของวัสดุที่เป็นองค์ประกอบ ดังนั้น การทำนายหรือคาดคะเนสมบัติของวัสดุเชิงประกอบจึงไม่
สามารถทำนายได้จากวัสดุที่เป็นองค์ประกอบชนิดใดเพียงชนิดเดียว องค์ประกอบของวัสดุเชิง
ประกอบ ได้แก่ วัสดุที่เป็นเนื้อหลักและเป็นเฟสต่อเนื่อง เรียกว่า เมทริกซ์ (Matrix) และวัสดุส่วน
เหลือที่กระจายตัวอยู่ในวัสดุเนื้อหลักนั้นเรียกว่า สารเสริมแรง (Reinforcement) โดยเมทริกซ์จะทำ
หน้าที่ห่อหุ้มสารเสริมแรงและทำให้วัสดุเชิงประกอบเป็นรูปร่างขึ้น ส่วนสารเสริมแรงจะทำหน้าที่เสริม
สมบัติให้เมทริกซ์และทำให้วัสดุเชิงประกอบมีสมบัติตามต้องการ วัสดุเชิงประกอบประกอบด้วยส่วน
สำคัญ 2 ส่วน ได้แก่ เมทริกซ์และสารเสริมแรง ดังนั้น ถ้าจำแนกวัสดุเชิงประกอบตามชนิดของวัสดุที่
เป็น เมทริกซ์จะสามารถจำแนกออกเป็น 3 ประเภท ได้แก่ วัสดุเชิงประกอบพอลิเมอร์ (Polymer 
matrix composite, PMC) วัสดุเชิงประกอบ โลหะ (Metal matrix composite, MMC) และ วัสดุ
เชิงประกอบเซรามิก (Ceramic matrix composite, CMC)  
 2.1.1 วัสดุเชิงประกอบพอลิเมอร์ 
  โดยธรรมชาติพอลิเมอร์เป็นสารประกอบ อินทรีย์ขนาดใหญ่ที่มีโครงสร้างเป็นหน่วย
ซ้ำเชื่อมต่อ กันเป็นสายยาว ทำให้พอลิเมอร์มีความแข็งแรงไม่ สูงนัก มีความหนาแน่นต่ำ และมีความ
ทนทานต่อการ กัดกร่อน การเสริมแรงให้พอลิเมอร์ทำได้โดยการ เติมเส้นใยเสริมแรงลงในพอลิเมอร์
ให้เกิดเป็นวัสดุ เชิงประกอบที่มีความแข็งแรงมากขึ้น โดยทั่วไปเส้นใย  เสริมแรงสำหรับวัสดุเชิง
ประกอบพอลิเมอร์มักเป็น เส้นใยที่มีความแข็งแรงสูงเพ่ือทำหน้าที่ในการรับ และกระจายแรงกระทำ 
โดยวัสดุ เชิ งประกอบจะมี  ความแข็งแรงสูงที่ สุดตามแนวการเรียงตัวของเส้นใย เสริมแรง             
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การเสริมแรงนี้ทำให้เมทริกซ์พอลิเมอร์ สามารถรับแรงกระทำได้สูงขึ้นโดยไม่เปลี่ยนรูปร่าง ที่แสดงถึง
สมบัติเชิงกลอย่างง่าย ของวัสดุเชิงประกอบพอลิเมอร์เมื่อให้แรงตามแนว การเรียงตัวของเส้นใย 
สมบัติเชิงกลนี้จะเป็นสมบัติร่วมที่เกิด  จากสมบัติของเมทริกซ์พอลิเมอร์ และสมบัติของเส้นใย
เสริมแรงประกอบกันทำให้วัสดุ เชิงประกอบมีความแข็งแรงเพ่ิมขึ้นมากกว่าวัสดุพอลิเมอร์ เนื่องจาก
เส้นใยเสริมแรงทำหน้าที่รับแรงกระทำ แต่สำหรับระยะยืดสูงสุดนั้น วัสดุเชิงประกอบจะมี
ความสามารถในการ ยืดสูงสุดได้ไม่เกินระยะยืดสูงสุดของเส้นใยเสริมแรง สำหรับเมทริกซ์พอลิเมอร์
ควรมีความเหนียวทนทานมากพอท่ีจะห่อหุ้มเส้นใยเสริมแรงไว้ สารเสริมแรงในรูปอนุภาค มีส่วนเสริม
ความแข็งแรงได้ ไม่ดีเท่ากับรูปเส้นใย เนื่องจากความไม่ต่อเนื่องของสาร  เสริมแรงส่งผลต่อการ
กระจายแรงจึงนิยม เรียกสารเสริมแรงในรูปอนุภาคว่า สารเติม (Filler) วัสดุเชิงประกอบจะมีความ
แข็งแรงมากขึ้นอย่างมากเมื่อเปรียบเทียบกับ  ความหนาแน่นที่ เพ่ิมขึ้นเพียงเล็กน้อยทำให้           
ความแข็งแรงจำเพาะ (Specific strength) ซึ่งเป็นอัตราส่วนระหว่างความแข็งแรงต่อความหนาแน่น
ของวัสดุเพ่ิมสูงขึ้น จึงทำให้สามารถนำวัสดุเชิงประกอบมาใช้สำหรับงาน โครงสร้างบางชนิดที่ต้องรับ
แรงกระทำที่ไม่สูงมากนักได้ เช่น เฟอร์นิเจอร์ต่าง ๆ สำหรับเมทริกซ์พอลิเมอร์สามารถแบ่งย่อย
ออกเป็ น เมทริกซ์ เทอร์ โม เซตติ ง  (Thermosetting matrix) และเมทริกซ์ เทอร์ โมพลาสติก 
(Thermoplastic matrix) ที่ มี ความแตกต่ างกัน ในพฤติกรรมเชิ งความร้อนของพอลิ เมอร์             
โดยเทอร์โมเซตติงเป็นพอลิเมอร์ที่มีโครงสร้างแบบร่างแหและมีสมบัติแข็งเปราะ เมื่อเกิดปฏิกิริยาการ
เชื่อมโยงโมเลกุล หรือการบ่มแล้วจะเกิดการคงรูปและไม่สามารถเปลี่ยนแปลงรูปร่างได้อีก         
ส่วนเทอร์โมพลาสติกเป็นพอลิเมอร์ที่มีโครงสร้างแบบเส้นหรือแบบกิ่ง สามารถหลอมเหลวได้เมื่อได้รับ
ความร้อนเหนืออุณหภูมิหลอมเหลว มีสมบัติเหนียวและทนทานต่อสิ่งแวดล้อม พฤติกรรมเชิงความ
ร้อนนี้จะมีผลต่อกระบวนการขึ้นรูปวัสดุเชิงประกอบสำหรับเมทริกซ์เทอร์โมเซตติง การขึ้นรูปวัสดุ   
เชิงประกอบจะเป็นการผสมสารเสริมแรงให้เข้ากับมอนอเมอร์ในแม่พิมพ์ ก่อนที่จะทำให้เกิด  
ปฏิกิริยาเคมีเชื่อมโยงเป็นโครงสร้างแบบร่างแหและหลังจากท่ีปฏิกิริยาสิ้นสุดวัสดุเชิงประกอบจะเกิด
การคงรูปซึ่งจะไม่สามารถเปลี่ยนแปลงรูปร่างได้อีก ในขณะที่การขึ้นรูปวัสดุเชิงประกอบที่ เมทริกซ์
เป็นเทอร์โมพลาสติกนั้นจะใช้หลักการ ให้ความร้อนเหนืออุณหภูมิหลอมเหลวและขึ้นรูปก่อนที่จะทำ
ให้เย็นตัวลงเพ่ือเกิดการคงรูป โดยถ้าหลังจากคงรูปแล้วได้รับความร้อนอีกครั้ง ส่วนที่เป็นเมทริกซ์ก็
จะสามารถหลอมเหลวได้อีก การที่จะเลือกใช้เมทริกซ์ชนิดใดนั้นขึ้นอยู่กับสมบัติในการประยุกต์ใช้งาน
เป็นสำคัญ ในอุตสาหกรรมวัสดุเชิงประกอบ วัตถุดิบ สำหรับการผลิตอาจอยู่ในรูปของชิ้นงานกึ่ง
สำเร็จ หรือพรีเพรก (Prepreg) เพ่ือความสะดวกในการขึ้นรูป ถ้าเป็นพรีเพรกของวัสดุเชิงประกอบ 
เมทริกซ์เทอร์โมเซตติงจะเป็นเส้นใยที่อยู่ในเมทริกซ์เทอร์โมเซตติง แต่ทำให้เกิดการเชื่อมโยงโมเลกุล
เพียงบางส่วนเท่านั้น และเมื่อจะนำมาขึ้นรูปเป็นรูปร่างที่ต้องการแล้วจึงจะทำให้เกิดการเชื่อมโยง
โมเลกุลที่สมบูรณ์ พรีเพรกลักษณะนี้อาจมาในรูปแผ่น ที่เรียกว่า พรีเพรกผสมเสร็จแบบแผ่น    



4 
  
สำหรับการขึ้นรูปเป็นชิ้นงานที่มีลักษณะแผ่น และ พรีเพรกผสมเสร็จแบบหนา (Bulk molding 
compound, BMC) จะใช้สำหรับการขึ้นรูปเป็น ชิ้นงานที่มีรูปทรงความแตกต่างกันของพรีเพรก    
ทั้งสองชนิดจะอยู่ที่ความยาวของเส้นใยเสริมแรง และความหนืดของเมทริกซ์ พรีเพรกแบบแผ่น 
มักจะทำจากเส้นใยยาวและมีความสามารถในการไหลของเมทริกซ์น้อยกว่า ส่วนพรีเพรกแบบหนา  
มักจะทำจากเส้นใยสั้น และความสามารถในการไหลสูงเพ่ือความเหมาะสมสำหรับการขึ้นรูปเป็น  
ชิ้นงานสำหรับพรีเพรกของวัสดุเชิงประกอบเทอร์โมพลาสติกนั้น จะอยู่ในรูปแผ่นที่เป็นเส้นใย      
แก้วสั้นๆ ในเมทริกซ์พอลิโอเลฟิน ที่ เรียกว่า  พรีเพรกผืนแก้วเทอร์โมพลาสติก (Glass mat 
thermoplastic, GMT) โดยพรีเพรกเมื่อได้รับ ความร้อนเหนืออุณหภูมิหลอมเหลวของเมทริกซ์    
และทำให้เป็นรูปร่างที่ต้องการก่อนที่จะถูกทำให้ เย็นตัวลงและคงรูป ไฟเบอร์กลาสส์หรือไฟเบอร์ 
เป็นตัวอย่าง ของวัสดุเชิงประกอบพอลิเมอร์ที่มีเมทริกซ์ เทอร์โมเซตติงเสริมแรงด้วยเส้นใยแก้วที่มี
ส่วนแบ่งทางการตลาดสูง โดยทั่วไปหมายถึงเมทริกซ์พอลิเอสเตอร์หรือไวนิลเอสเตอร์ไฟเบอร์กลาสส์ 
จะนำไปประยุกต์ใช้ในงานที่ต้องการความแข็งแรง ปานกลาง น้ำหนักเบา เช่น หลังคารถกระบะ 
เฟอร์นิเจอร์ขนาดเล็ก เป็นต้น ส่วนเมทริกซ์ อีพอกซีจะถูกใช้ในงานที่ต้องการความแข็งแรง สูงกว่า 
นอกจากนี้ยังมีการนำเส้นใยเสริมแรง อ่ืน ๆ ได้แก่ เส้นใยคาร์บอน และมีความแข็งแรงสูงกว่าเส้นใย
แก้วมาใช้ในงานที่ต้องการสมบัติด้านความแข็งแรงสูงมาก ส่วนวัสดุเชิงประกอบเมทริกซ์เทอร์โม
พลาสติกมีส่วน แบ่งทางการตลาดน้อยกว่า มักใช้ทำเป็นวัสดุสำหรับตกแต่งภายในที่ต้องการความ
เหนียว ทนทาน หรือนำไปอัดซ้อนกับวัสดุอ่ืนเพื่อเพ่ิมความแข็งแรง เป็นต้น 

2.1.2 วัสดุเชิงประกอบโลหะ 
วัสดุเชิงประกอบโลหะได้พัฒนาขึ้นเพ่ือ ปรับปรุงความสามารถในการทนทานต่อ

ความล้าของโลหะให้ดีมากข้ึน โดยเฉพาะอะลูมิเนียม และไทเทเนียม ที่เป็นเมทริกซ์โลหะท่ีต้องการให้ 
มีสมบัติพิเศษในการใช้งานในอุตสาหกรรมอวกาศยาน สารเสริมแรงอาจอยู่ในลักษณะของอนุภาค  
เส้นใยหรือวิสเกอร์ก็ได้นอกจากนี้สารเสริมแรง สำหรับโลหะต้องมีความแข็งแรงสูง และทนต่อความ
ร้อนสูงด้วย เนื่องจากโลหะต้องใช้อุณหภูมิสูงมากในการขึ้นรูป และสารเสริมแรงที่ใช้ต้องไม่เกิดการ  
กัดกร่อนกับเมทริกซ์โลหะ จากข้อจำกัดเหล่านี้  ทำให้สารเสริมแรงอนินทรีย์และเส้นใยแก้ว           
ไม่สามารถใช้เสริมแรงให้กับเมทริกซ์โลหะได้  สารเสริมแรงที่ใช้จึงต้องเป็นสารเสริมแรงเซรามิก    
หรือสารเสริมแรงโลหะ เช่น ซิลิกอนคาร์ไบด์ อะลูมินา เส้นใยโบรอน เป็นต้น การเสริมแรงเป็นการทำ
ให้เมทริกซ์โลหะมีความทนทานต่อความล้าสูงขึ้นมาก และมีอายุการใช้งานนานขึ้นอีกทั้งความ
หนาแน่นของสารเสริมแรงที่น้อยกว่าโลหะ ทำให้ความหนาแน่นของวัสดุเชิงประกอบลดลงรวมถึง
สัมประสิทธิ์การขยายตัวเนื่ องจากความร้อน  (Coefficient temperature expansion, CTE)    
ลดลงเพราะสารเสริมแรงเป็นเซรามิกจึงมีการขยายตัวเนื่องจากความร้อนต่ำกว่าโลหะส่วนกรณีที่  
สารเสริมแรงมีลักษณะเป็นเส้นใยยาววัสดุเชิงประกอบที่ได้จะมีความแข็งแรงสูงขึ้นมากอีกด้วย  
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โดยทั่วไปวัสดุเชิงประกอบโลหะจะนำไป ใช้งานในลักษณะเดียวกับโลหะ สารเสริมแรงที่เติมเข้าไปจะ
เป็นการปรับปรุงสมบัติของเมทริกซ์ โลหะให้ดียิ่งขึ้น และมีอายุการใช้งานนานขึ้น อย่างไรก็ตามการ
นำไปใช้งานยังจำกัดเนื่องจาก ต้นทุนในการผลิตที่สูงมาก 

2.1.3 วัสดุเชิงประกอบเซรามิก 
เซรามิกเป็นวัสดุที่มีความทนทานต่อการใช้งานที่ อุณหภูมิสูง ไม่นำความร้อน 

ทนทานต่อการกัดกร่อน และอัตราการเปลี่ยนแปลงรูปร่าง เมื่อได้รับความร้อนต่ำมากเซรามิกจึง
นำมาใช้ในงานที่ต้องการความทนทานต่ออุณหภูมิสูง และในสภาวะที่มีการกัดกร่อนสูง แต่ข้อเสียของ 
เซรามิก คือ เปราะและแตกหักง่าย เมื่อเกิดรอยแตกแล้วไม่สามารถซ่อมแซมได้โดยง่าย การเสริมแรง
ให้กับเมทริกซ์เซรามิกเป็นการปรับปรุงสมบัติให้ วัสดุเชิงประกอบที่ได้มีความเหนียวและทนทานมาก
สารเสริมแรงจะเข้าไปขวางการแพร่ของรอยแตกที่อาจเกิดขึ้น ระหว่างการใช้งานเมื่อวัสดุเชิงประกอบ
ได้รับแรงจะไม่เกิดการเปราะแตกในทันทีเนื่องจาก รอยแยกจะถูกหน่วงด้วยสารเสริมแรงเนื่องจาก 
สมบัติที่เรียกว่า ความเหนียวแบบเทียม (Pseudo ductile) สำหรับเมทริกซ์เซรามิกที่ไม่เสริมแรง   
จะแสดงสมบัติที่เปราะและแตกทันทีเมื่อได้รับแรงกระทำจนถึงจุดจุดหนึ่ง ดังนั้น การใส่สารเสริมแรง
เข้าไปจะทำให้วัสดุเชิงประกอบเซรามิกที่ ได้มีความเหนียวทนทานมากขึ้น สารเสริมแรงที่ใช้ในการ
เสริมแรงอาจอยู่ ในรูปอนุภาค เส้นใย  หรือวิสเกอร์ ได้แก่  อะลูมินา ซิลิกา ซิลิกอนคาร์ ไบด์           
และคาร์บอน เป็นต้น และสำหรับเมทริกซ์เซรามิก ได้แก่ ซีเมนต์ คาร์บอน ซิลิ- กอนคาร์ไบด์เป็นต้น 
วัสดุเชิงประกอบได้นำมาใช้งานเป็นเวลานานโดยเฉพาะการใช้เป็นวัสดุโครงสร้างที่ใช้เส้นโลหะและ
หินกรวดทรายต่าง ๆ เป็นสารเสริมแรงให้แก่เมทริกซ์ซีเมนต์หรือคอนกรีต สำหรับการพัฒนา
เทคโนโลยีคอนกรีตอาจทำโดยการใช้เส้นใยเสริมแรง เช่น เส้นใยแก้ว หรือเส้นใยคาร์บอน  แทนเส้น
โลหะเพ่ือแก้ปัญหาด้านการกัดกร่อนเมื่อใช้งานเป็นเวลานาน สำหรับวัสดุเชิงประกอบเซรามิกข้ันสูงที่
มีความเหนียวทนทานต่อการกัดกร่อน และสามารถประยุกต์ใช้ในงานที่อุณหภูมิสูงนั้นยังมีการใช้งาน
อย่างจำกัดเนื่องจากต้นทุนในกระบวนการผลิตที่สูง 
 
2.2  เหล็กกล้าไร้สนิม (Stainless Steel) [2] 

เหล็กกล้าไร้สนิมหรือที่เรียกกันอีกอย่างว่าสแตนเลสมีส่วนผสมหลักคือโลหะโครเมียม     
และนิกเกิล การที่ไม่เกิดสนิมนั้นเกิดจากโครเมียมจะทำปฏิกิริยากับอากาศเกิดเป็นชั้นฟิล์มบางๆ  
คลุมผิวเอาไว้  เรียกว่าฟิล์มโครเมียมออกไซด์ เหล็กกล้าไร้สนิมเป็นวัสดุที่นิยมใช้ในการสร้างอุปกรณ์
เครื่องมือต่างๆ ที่ใช้ในอุตสาหกรรม เป็นวัสดุที่ ไม่เป็นสนิม แข็งแรง ทนทาน ขึ้นรูปได้ง่าย มีผิวสัมผัส
และรอยเชื่อมเรียบ ง่ายในการทำความสะอาด ทนการกัดกร่อน สามารถแบ่งได้เป็น 5 ประเภท  

2.2.1 เหล็กกล้าไร้สนิมเฟอร์ริติก เป็นกลุ่มเหล็กกล้าไร้สนิมที่เป็นพ้ืนฐานของเหล็กกล้าไร้
สนิมทั้งหมด ได้แก่ AISI 430 AISI 446 AISI 409 เป็นต้น เหล็กกล้าที่ผสมโครเมียมในปริมาณร้อยละ 
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12-27 ขึ้นอยู่กับแต่ละเกรด โดยความต้านทานต่อการกัดกร่อนจะขึ้นอยู่กับปริมาณของธาตุโครเมียม
เป็นสำคัญโดยเหล็กกล้าไร้สนิมกลุ่มนี้มีโครงสร้างจุลภาคเป็นเฟอร์ไรต์ ซึ่งเป็นโครงสร้างพ้ืนฐานของ
เหล็กกล้าทั่วไปไม่สามารถทำการชุบแข็งเพ่ือเพ่ิมความแข็งแรงได้ 
 2.2.2 เหล็ก ไร้สนิมออสเตนิติ ค เป็ น เหล็กกล้ าไร้สนิมที่ มี ธาตุผสมหลักอยู่  3 ธาตุ               
คือเหล็กโครเมียม และนิกเกิลที่มีปริมาณธาตุของโครเมียมอยู่ประมาณ 18 เปอร์เซ็นต์ และนิกเกิลที่มี
ปริมาณ 8 เปอร์เซ็นต์ เหล็กกล้าไร้สนิมประเภทนี้เรียกกว่ากลุ่มเกรด 300  
 2.2.3 เหล็กกล้าไร้สนิมมาร์เทนซิติก เป็นเหล็กกล้าไร้สนิมที่มีลักษณะคล้ายคลึงกับเหล็กกล้า
ไร้สนิมเฟอร์ริติก แต่มีปริมาณธาตุคาร์บอนที่สูงกว่า เพ่ือทำให้เหล็กกล้าไร้สนิมกลุ่มนี้สามารถทำการ
ชุบแข็ง (hardening) เพ่ือเพ่ิมความแข็งแรงได้ โดยเกรดที่รู้จักกันอย่างแพร่หลายเช่น AISI403 420 
เป็นต้น โครงสร้างจุลภาคภายหลังการชุบแข็งจะได้โครงสร้างมาร์เทนไซต์ การใช้งานเหล็กกล้าไร้สนิม
มาร์เทนซิติกส่วนใหญ่คำนึงถึงความแข็งแรงและความทนทานต่อการเกิดสนิมในระดับปานกลาง
เนื่องจากปริมาณคาร์บอนที่สูงจะทำให้ความต้านทานต่อการกัดกร่อนลดลง แต่ก็ยังคงไม่เป็นสนิมใน
สารละลายที่มีการกัดกร่อนไม่สูงมากนักหรือในสารละลายที่ เป็นกลางได้ ตัวอย่างการใช้งาน        
เช่น ลูกปืน เพลา เฟือง สปริง เป็นต้น 

2.2.4 เหล็กกล้าไร้สนิมสองเฟส เป็นเหล็กกล้าไร้สนิมที่มีลักษณะร่วมทางโครงสร้างจุลภาค
ระหว่างเหล็กกล้าไร้สนิมเฟอร์ริติกกับเหล็กกล้าไร้สนิมออสเทนนิติก แต่มีความแข็งแรงสูงกว่า
เหล็กกล้าไร้สนิมทั้ง 2 ชนิด โดยลักษณะโครงสร้างจุลภาคที่เกิดขึ้นในลักษณะนี้เกิดจากการมีปริมาณ
ของธาตุนิกเกิลไม่ถึงร้อยละ 8 และมีปริมาณของธาตุโครเมียมสูงมากกว่าร้อยละ 20 ซึ่งทำให้ได้
โครงสร้างผสมระหว่างเฟอร์ไรต์และออสเทนไนต์ตัวอย่างของกลุ่มนี้ เช่น AISI 329 เป็นต้นเหล็กกล้า
ไร้สนิมกลุ่มนี้มีราคาค่อนข้างแพงเนื่องจากมีความแข็งแรงและความทนทานต่อการกัดกร่อนสูง
เนื่องจากปริมาณโครเมียมสูง 

2.2.5 เหล็กกล้าไร้สนิมแบบตกผลึกแข็ง เป็นเหล็กกล้าไร้สนิมที่มีการใช้งานน้อยมากใน
ประเทศไทย โดยเหล็กกล้าไร้สนิมชนิดนี้มีความแข็งแรงสูง เนื่องจากเกิดการตกผลึกของเฟสต่างๆ 
เช่น Ni3 Al Ni3 Ti และ Ni3 Cu ภายในเนื้อวัสดุที่มีโครงสร้างมาร์เทนไซต์ เกรด AISI 17-4 PH 
โครงสร้างกึ่งออสเทนไนต์ เกรด AISI 17-7 PH หรือโครงสร้างออสเทนไนต์ เกรด AISI 600 ซึ่งจุดเด่น
ที่สำคัญของเหล็กกล้าไร้สนิมกลุ่มนี้คือ ชิ้นงานภายหลังจากการอบชุบมีโอกาสบิดเบี้ยวน้อย 

 
2.3  การเชื่อมเหล็กกล้าสแตนเลส (Welding of stainless steel) [2] 

ปัจจุบันนี้วิธีการเชื่อมส่วนใหญ่ที่ใช้กับเหล็กกล้าสแตนเลสก็คือ การเชื่อมไฟฟ้า การเชื่อม 
MIG และการเชื่อม TIG นอกจากนี้แล้วยังมีวิธีการเชื่อมแบบอ่ืน ซึ่งบางครั้งก็นำมาใช้เชื่อมเหล็กกล้า 
สแตนเลสเหมือนกัน เช่น การเชื่อมแบบซัมเมอร์จอาร์ค การเชื่อมแบบอิเล็กตรอนบีม และการเชื่อม
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แบบรีซิสแตนซ์ (Resistance Welding) เป็นต้นเนื่องจากเหล็กกล้าสแตนเลสเป็นเหล็กกล้าโลหะผสม
สูงอย่างหนึ่งซึ่งมีธาตุโลหะผสม (Alloy Element) อยู่หลายอย่าง ดังนั้น ความร้อนจาก การเชื่อม
ตลอดจนสิ่งแวดล้อมต่างๆ ที่เก่ียวข้อง เช่น บรรยากาศกัดกร่อน (Corrosive Atmosphere) อุณหภูมิ
สูง อุณหภูมิต่ำ จะมีผลต่อคุณสมบัติของเหล็กกล้าสแตนเลส ต่อไปจะได้กล่าวถึงความสามารถในการ
เชื่อม (Weldability) ของเหล็กกล้าสแตนแลสแต่ละชนิด 

2.3.1 ความสามารถในการเชื่อมเหล็กกล้าสแตนเลส (Martensility of Stainless Steel) 
  2.3.1.1 เหล็กกล้าสแตนเลสชนิดมาร์เทนซิติค (Martensitic type) ในการเชื่อม
ความร้อนเกิดขึ้นที่รอยเชื่อมอย่างรวดเร็ว และรอยเชื่อมก็เย็นตัวอย่างรวดเร็วด้วย ทำให้โครงสร้าง
บริเวณรอยเชื่อมของเหล็กกล้าสแตนเลสชนิดนี้เป็นมาร์เตนไซท์ ซึ่งโครงสร้างเช่นนี้เปราะ และรอย
เชื่อมจึงแตกง่าย นั้นคือความสามารถในการเชื่อมเหล็กกล้าสแตนเลสจึงไม่ดี มีสิ่งที่ควรระมัดระวังใน
การเชื่อมเหล็กกล้าสแตนเลสชนิดนี้ก็คือบ่มให้ความร้อน (Preheat) ชิ้นงานก่อนเชื่อมและรักษา
อุณหภูมิระหว่างเชื่อมไว้เช่นนี้หลังเชื่อมให้อบชุบที่อุณหภูมิ 700-800 องศาเซลเซียส 
  2.3.1.2 เหล็กกล้าสแตนเลสชนิดเฟอร์ริติค (Ferritic Type) กรณีของเหล็กกล้า 
สแตนเลสชนิดเฟอร์ริติค บริเวณ Heat Affected Zone ของรอยเชื่อมจะแข็ง แต่เกรนในบริเวณนี้จะ
หยาบมาก ซึ่งมีผลให้ความสามารถในการยืนตัว (Ductility) และความเหนียว (Toughness) ลดต่ำลง 
เมื่อรอยเชื่อมค่อย ๆ เย็นตัวผ่านช่วงอุณหภูมิ 600 องศาเซลเซียส ถึง 400 องศาเซลเซียส รอยเชื่อม
จะเปราะมาก โดยเฉพาะอย่างยิ่งที่อุณหภูมิ 475 องศาเซลเซียส ดังนั้นการเปราะในลักษณะเช่นนี้
เรียกว่า การเปราะที่อุณหภูมิ 475 องศาเซลเซียส ด้วยเหตุนี้เองในการเชื่อมเหล็กกล้าสแตนเลสชนิด
เฟอร์ริติค จึงควรที่จะเลือกปฏิบัติคือการบ่มชิ้นงานที่อุณหภูมิประมาณ 70 ถึง 100 องศาเซลเซียส 
เพ่ือป้องกันการแตกเย็น (Cold Cracking) และไม่ควรจะบ่มชิ้นงานมากเกินไปรอยเชื่อมควรเย็น
ตัวอย่างรวดเร็วในช่วงอุณหภูมิ 600 ถึง 400 องศาเซลเซียส 
  2.3.1.3 เหล็กกล้าสแตนเลสชนิดออสเตนิติค (austenitic type) ความสามารถใน
การเชื่อมของเหล็กกล้าชนิดนี้ดีกว่า ชนิดแรกที่กล่าวมา แต่ปัญหาของการเชื่อมเหล็กกล้าชนิดนี้ก็คือ 
ในขณะที่เหล็กกล้าค่อย ๆ เย็นตัวจากอุณหภูมิ 680 องศาเซลเซียส ถึง 480 องศาเซลเซียส ภายหลัง
การเชื่อมนั้น C และ Cr ในโครงสร้างออสเตไนท์จะรวมตัวกัน เกิดเป็นสารประกอบโครเมียมคาร์ไบด์ 
ตกตะกอนที่ขอบเกรน การตกตะกอนของโครเมียมคาร์ไบด์เช่นนี้จะเกิดได้ดีที่อุณหภูมิ 650 องศา
เซลเซียสปรากฏการณ์ดังกล่าวมานี้เรียกว่า เวลด์ ดีเค ซึ่งทำให้คุณสมบัติในการต้านทานการกัดกร่อน 
และคุณสมบัติทางกลของเหล็กกล้าสแตนเลสลดลง 
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รูปที ่2.1 การตกตระกอนของโครเมียมคาร์ไบด์ที่ขอบเกรนของเหล็กกล้า18 Cr – 8 Ni [2] 

 
 

รูปที ่2.2  Schaeffer’s Diagram ของโลหะรอยเชื่อมในเหล็กกล้าสแตนเลส [2] 
 

 ส่วนผสมทางเคมีและโครงสร้างมีผลต่อคุณสมบัติทางกล และความต้านทานการกัดกร่อน
ของโลหะรอยเชื่อม ในเหล็กกล้าสแตนเลสเป็นอย่างมาก ดังรูปจะเห็นได้ว่าโครงสร้าง ซึ่งแสดง
ความสัมพันธ์ระหว่างส่วนผสมทางเคมี (Ni เทียบเท่า และ Cr เทียบเท่า) ของเหล็กกล้าชนิดสแตนเลส
กับโครงสร้าง 
 เป็นที่เข้าใจแล้วว่าเหล็กกล้าสเตนเลสชนิดออสเตนิติค เฟอร์ริติค และออสเตนิติคมีจุดเสีย
ตรงที่เกิดการเปราะ และแตกได้ในรอยเชื่อม จึงจาเป็นที่จะต้องควบคุมโลหะรอยเชื่อมให้อยู่ภายใน
บริเวณศูนย์กลางของความปลอดภัย (Central of Safety Zone) 
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รูปที ่2.3  รอยแตกชนิดต่าง ๆ ในงานเชื่อม [2] 
 

 เหล็กกล้าสแตนเลสซึ่งมีโครงสร้างเป็นออสเตไนท์ทั้งหมด มีความโน้มเอียงที่จะเกิดรอยแตก
ร้อน (Hot cracks) ซึ้งมีอยู่หลายชนิดด้วยกัน ถ้าหากมีโครงสร้างเฟอร์ไรท์ 4 เปอร์เซ็นต์ ในโครงสร้าง
แล้วสามารถทำให้การแตกร้าวลดน้อยลง เพราะฉะนั้นในการเชื่อมเหล็กกล้าสแตนเลสควรระมัดระวัง
ในสิ่งเหล่านี้ไม่ต้องบ่มชิ้นงานก่อนเชื่อม แต่ให้ลดความร้อนเชื่อม เพ่ือหลีกเลี่ยงการตกตะกอน      
คาร์ไบด์ที่ขอบเกรนใช้ลวดเชื่อมไฟฟ้าชนิด Nb ชนิด Ti หรือชนิดคาร์บอนต่ามากๆเลือกใช้ลวดเชื่อม
ชนิดที่ทำให้เกิดโครงสร้างของโลหะรอยเชื่อมอยู่ภายใต้บริเวณปลอดภัยของแผนภาพแชฟเลอร์ 

 
2.4 ระบบส่งกำลัง (Powertrain System)  

2.4.1 มอเตอร์ (Motor) [2] 
 มอเตอร์เป็นอุปกรณ์ไฟฟ้าที่เปลี่ยนพลังงานไฟฟ้าให้เป็นพลังงานกล การทำงานปกติ

ของมอเตอร์ไฟฟ้าส่วนใหญ่เกิดจากการทำงานร่วมกันระหว่างสนามแม่เหล็กของแม่เหล็กในตัว
มอเตอร์และสนามแม่เหล็กท่ีเกิดจากกระแสในขดลวดทำให้เกิดแรงดูดและแรงผลักของสนามแม่เหล็ก
ทั้งสองกำลังเอาท์พุตคือกำลังที่ส่งมาจากเพลาของมอเตอร์กำหนดเป็นแรงม้า ในปัจจุบันได้กำหนดค่า
จากแรงม้าเป็นกิโลวัตต์ เป็นมาตรฐานทั่วโลก แบ่งมอเตอร์เป็น 2 ประเภท 
  1. มอเตอร์ไฟฟ้ากระแสสลับ (Alternating current motor) เป็นเครื่องกลไฟฟ้าที่
ทำหน้าที่เปลี่ยนพลังงานไฟฟ้าให้เป็นพลังงานกล ส่วนที่ทำหน้าที่เปลี่ยนพลังงานไฟฟ้าคือขดลวดในส
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เตเตอร์และส่วนที่ทำหน้าที่ให้พลังงานกล คือ ตัวหมุนหรือโรเตอร์  ซึ่งเมื่อขดลวดในสเตเตอร์ได้รับ
พลังงานไฟฟ้าก็จะสร้างสนามแม่เหล็กขึ้นมาในตัวที่อยู่กับที่หรือสเตเตอร์ ซึ่งสนามแม่เหล็กที่เกิดขึ้นนี้
จะมีการเคลื่อนที่หรือหมุนไปรอบๆ สเตเตอร์  เนื่องจากการต่างเฟสของกระแสไฟฟ้าในขดลวดและ
การเปลี่ยนแปลงของกระแสไฟฟ้า  ในขณะที่สนามแม่เหล็กเคลื่อนที่ไปสนามแม่เหล็ก จากขั้วเหนือก็
จะพุ่งเข้าหาขั้วใต้ ซึ่งจะไปตัดกับตัวนำที่เป็นวงจรปิดหรือขดลวดทรงกระบอกของตัวหมุนหรือโรเตอร์ 
ทำให้เกิดการเหนี่ยวนำของกระแสไฟฟ้าขึ้นในขดลวดของโรเตอร์  ซึ่งสนามแม่เหล็กของโรเตอร์นี้จะ
เคลื่อนที่ตามทิศทางการเคลื่อนที่ของสนามแม่เหล็กที่สเตเตอร์ก็จะทำให้โรเตอร์ของมอเตอร์เกิด
พลังงานกลสามารถนำไปขับภาระที่ต้องการหมุนได้ 
  2. มอเตอร์ไฟฟ้ากระแสตรง (Direct current motor) มอเตอร์ไฟฟ้ากระแสตรง
เป็นต้นกำลังขับเคลื่อนที่สำคัญอย่างหนึ่งในโรงงานอุตสาหกรรมเพราะมีคุณสมบัติที่ดีเด่นในด้านการ
ปรับความเร็วได้ ต้ั งแต่ความเร็วต่ ำสุดจนถึงสู งสุดนิ ยมใช้กันมากในโรงงานอุตสาหกรรม                
เช่น โรงงานทอผ้า โรงงานเส้นใยโพลีเอสเตอร์ โรงงานถลุงโลหะ หรือให้เป็นต้นกำลังในการขับเคลื่อน
รถไฟฟ้าในการศึกษาเกี่ยวกับมอเตอร์ไฟฟ้ากระแสตรงจึงควรรู้จักอุปกรณ์ต่างๆ ของมอเตอร์ไฟฟ้า
กระแสตรงและเข้าใจถึงหลักการทำงานของมอเตอร์ไฟฟ้ากระแสตรงแบบต่างๆ 
 การคำนวณหาขนาดของมอเตอร์เพ่ือใช้เป็นต้นกำลังขับเคลื่อนระบบทางกลนั้นเป็นสิ่งที่ต้อง
ทราบเป็นอันดับแรง คือ ขนาดของแรงบิด (Torque) ที่ใช้ซึ่งคำนวณหาได้จากสมการ 
 

T F r=   (2.1) 
 โดย 
  T     =  แรงบิด (Torque) หน่วยเป็น (N.m) 
  F  =  แรงกระทำต่อเพลา หน่วยเป็น (N) 
  r  =  รัศมีเพลา หน่วยเป็น (m) 
 เมื่อทราบขนาดของแรงบิดรวมที่ตอ้งใชข้บัเคลื่อนระบบทางกลแลว้สามารถค านวณหา
ขนาดของมอเตอรไ์ฟฟ้าไดจ้ากสมการ 
 

2 NT
P

60


=  (2.2) 

 โดย 
  P     =  กำลังของมอเตอร์ หน่วยเป็น (W) 
  N  =  ความเร็วรอบของมอเตอร์ หน่วยเป็น (rpm) 
  T  =  แรงบิด (Torque) หน่วยเป็น (N.m) 
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2.4.2 เพลา (Shaft) [2] เพลาส่งกำลังเป็นชิ้นส่วนของเครื่องจักรกลที่สำคัญในการที่จะส่ง
ถ่ายกำลังหมุนที่ต้องต้านทานต่อแรงบิด เช่นเพลาที่สวมอยู่พลูเล่ย์และเฟืองเป็นต้น ซึ่งเพลาจะมี
พ้ืนที่หน้าตัดเป็นวงกลมหมุนรอบตัวเอง ทำหน้าที่ส่งผ่านโมเมนต์บิดและโมเมนต์ดัด ดังนั้นวัสดุที่จะ
นำมาทำเพลาจะต้องทนต่อแรงบิดและแรงดัดได้ดีในกรณีที่ต้องการความแข็งแรงสูงและทนต่อการใช้
แรงมากเพลาอาจทำจากพวกเหล็กผสม ซึ่งในการออกแบบจะต้องพิจารณาถึงกำลังงาน (Power) 
ภาระ (Load)   ที่ให้เพลาส่งกำลังความเค้นที่เกิดข้ึนกับเพลา ซึ่งเป็นสาเหตุในการเกิดความเค้นขึ้น ณ 
ตำแหน่งต่างๆของเพลา เมื่อส่งกำลังจากเพลาหนึ่งไปอีกเพลาหนึ่งจะทำให้เกิดแรงมากระทำต่อเพลา 

ค่าความเค้นที่เกิดขึ้นควรน้อยกว่าค่าจากสมการค่าความเค้นออกแบบเพ่ือให้การออกแบบมี
ความปลอดภัยสูงภาระที่เพลารับมักจะมาจาก bending moment และแรงบิด โดยแรงในแนวแกน
มักจะมีค่าน้อย ความเค้นที่เกิดในเพลามีสมการดังนี้ 

 
  1. ความเค้นดัด [3]  

b
MC

I
 =  (2.3) 

 โดย 
  b     =  ความเค้นดัด (Bending Stress) หน่วยเป็น (N/mm2) 
  M   =  โมเมนต์ดัด หน่วยเป็น (N.mm) 
  C   =  ระยะจากแกนสะเทินไปยังผิวนอกสุด หน่วยเป็น (mm) 
  I   =  โมเมนต์ความเฉื่อยของพ้ืนที่ หน่วยเป็น (mm4) 
 
  2. ความเค้นเฉือน [3] 

Tr

J
 =  (2.4) 

 โดย 
     =  ความเค้นเฉือน (Shear stress) หน่วยเป็น (N/mm2) 
  T   =  แรงบิด (Torque) หน่วยเป็น (N.mm) 
  r  =  รัศมีเพลา หน่วยเป็น (mm) 
  J =  โมเมนต์ความเฉื่อยเชิงขั้วของพ้ืนที่ (Polar Area Moment of Inertia) 
    หน่วยเป็น (mm4) 
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  3. ความเค้นเฉือนสูงสุด [3] 

2/1
2

2
21

max 22








+







=
−

= 


  (2.5) 

  

จาก      max   =   y

y2N


    (2.6) 

 โดย 
  max   =  ความเค้นเฉือนสูงสุด หน่วยเป็น N/mm2 
      =  ความเค้น (Stress) หน่วยเป็น N/mm2 
      =  ความเค้นเฉือน (Shear stress) หน่วยเป็น N/mm2 
  y   =  ความต้านแรงดึงคราก หน่วยเป็น N/mm2 

  yN   =  ค่าความปลอดภัยเมื่อถือความแรงดึงครากเป็นหลัก 

 
2.4.3 ระบบส่งกำลังด้วยโซ่ [4] 

  ระบบการส่งกำลังของเครื่องจักรกลที่ใช้ตามโรงงานอุตสาหกรรมโดยทั่วไปมีหลาย
อย่างแล้วแต่ความเหมาะสมของแต่ละประเภทงานที่ทำ ซึ่งในที่นี้จะเลือกการส่งกำลังด้วยโซ่สามารถ
ส่งกำลังให้ได้โมเมนต์บิด (หมุน) สูงมากโดยที่ให้เป็นชุดส่งกำลังมีขนาดเล็กได้ เป็น ลักษณะการส่ง
กำลังด้วยรูปร่างและที่รอง เพลาจะรับภาระน้อยมาก ไม่มีการให้ลื่นไถลในขณะส่งกำลัง ในขณะส่ง
กำลังข้อต่อโซ่จะรับภาระความเสียดทานลื่น (Sliding Friction) จึงต้องมีการหล่อลื่นที่เพียงพอโซ่ส่ง
กำลังจะมีใช้งานในที่รับภาระดึงมากๆ ในที่รับ อุณหภูมิสูง , โรงงานเคมี, ไอน้ำมัน, ความชื้นเป็นที่ซึ่ง
สายพานไม่สามารถนำไปใช้งานได ้ซึ่งระบบส่งกำลังจะประกอบด้วย โซ่ และ ล้อโซ่  
  โซ่ (Chain) จะเป็นแบบโซ่ฟัน จะมีรูปร่างฟันแต่ละข้อชัดเจน ฟันของโซ่จะจับลงใน
ร่องฟันของล้อโซ่พอดี โซ่ฟันที่ใช้งานรับกาลังงานสูง ๆ แผ่นฟันที่ข้อต่อจะไม่ยึดด้วยโบลต์ แต่จะยึด
ด้วยข้อต่อลูกกลิ้งที่มีความเสียดทานน้อยและทนต่อการสึกหรอได้ดี  โซ่ฟันใช้รับกำลังงานได้สูง     
และเกือบจะไม่มีเสียงดังในขณะมีความเร็วโซ่ถึง 40 m/s 
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รูปที่ 2.4 ส่วนประกอบของโซ่ฟัน [4] 
 

  ล้ อ โซ่  (Sprockets) ตามปกติ ล้ อ โซ่ จะท ำจาก เหล็ กหล่ อ , เห ล็ กกล้ าหล่ อ           
หรือเหล็กกล้า ส่วนการจัดให้ขับส่งกำลังด้วยโซ่ที่ถูกต้องให้ดูรูปที่ 2.2 (ก) และ (ข) 
 

 
 

รูปที่ 2.5 การติดตั้งโซ่และล้อโซ่ [4] 
 ก. เฟืองขับและเฟืองตามของโซ่ทำมุมเอียงไม่ควรมากกว่า 60 องศา จากแนวนอน  
 ข. หากต้องการให้โซ่จับกับเฟืองโซ่มากข้ึนก็ให้มีเฟืองสะพานอยู่ใกล้เฟืองขับเสมอ 
 
  การออกแบบสำหรับล้อโซ่ที่ใช้กับโซ่ฟันจะต้องมีจำนวนฟันอย่างน้อยที่สุด 17 ฟัน 
มิฉะนั้นจะเกิดสัดส่วนการจับของโซ่ ฟันที่ ไม่ เหมาะสม  ที่ทำให้ เกิดแรงเสียดทานมากขึ้นได้            
และถ้าใช้งานรับภาระกระแทกแล้วโซ่ฟันจะยืดและมีผลให้เกิดสัดส่วนการจับของโซ่ฟันที่ไม่เหมาะสม
อีกเช่นกัน  โซ่จะเกิดการสึกหรอรวดเร็วหากล้อโซ่มี จำนวนฟันต่ำกว่า 12 ฟัน ลำเลียง ตามมาตรฐาน 
DIN 8165, 8175 และ DIN 8176 เป็นโซ่แบบข้อต่อชนิดหนึ่งที่ทำหน้าที่นำพาชิ้นส่วนหรือผลิตภัณฑ์ 
โดยจะออกแบบรูปร่างแผ่นปิดด้านข้างให้มีรูปร่างต่างๆ  กัน เพ่ือให้สามารถนำพาผลิตภัณฑ์ตาม
รูปร่างที่ต้องการได้ โซ่ลำเลียงส่วนใหญ่จะนำมาใช้งานให้รับภาระไม่มากนักและมีความเร็วโซ่ต่ำ 
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  ข้อดี : สามารถออกแบบให้มีขนาดเส้นผ่านศูนย์กลางของล้อโซ่ให้มีขนาดเล็กมากๆ 
และยังเดินได้เงียบอีกด้วย  
  ข้อเสีย : จะเกิดการยืดตัวยาวออกหากใช้งานรับภาระมากเกินไป ซึ่งจะทำให้โซ่จับ
ฟันล้อโซ่ไม่ถูกต้อง นอกจากนี้ยังสามารถ ให้เบนไปด้านข้างได้น้อย ด้วยเหตุนี้ล้อโซ่จะต้องประกอบให้
ได้ตำแหน่งที่เที่ยงตรงกับแนววิ่งของโซ่ มิฉะนั้นจะเกิดการสึกหรอของโซ่สูง 
 2.4.4 ตลับลูกปืน (Bearing) [2] 
  ตลับลูกปืน คือ ชิ้นส่วนเครื่องจักรกลที่ใช้รองรับเพลา เพ่ือให้เพลานั้นรับภาระให้
หมุนได้เป็นไปอย่างราบรื่น ปลอดภัยและมีอายุการใช้งานทนทาน นอกจากนี้จะต้องแข็งแกร่งและมี
ความเที่ยงตรง ตลับลูกปืนเหมาะสำหรับรับภาระที่ไม่มาก ถ้าใช้ในงานที่มีความเร็วต่ำ อายุการใช้งาน
ของตลับลูกปืนก็จะสูงขึ้น ในช่วงเริ่มหมุนจะมีความฝืดน้อยจึงมีชื่อเรียกอีกอย่างหนึ่งว่าเป็นชิ้นส่วนที่
ไม่มีความฝืด (Antifriction) แต่ที่จริงแล้วความฝืดเกิดจากการต้านทานการกลิ้งระหว่างเม็ดลูกปืน
นอกจากนี้ยังเกิดจากแรงเฉือนของสารหล่อลื่น ตลับลูกปืนมีอยู่หลายชนิดด้วยกัน แต่ละชนิดจะขึ้นอยู่
กับการออกแบบให้เหมาะสมกับการใช้งานในแต่ละลักษณะซึ่งสามารถจำแนกออกได้ 3 ชนิดใหญ่ ๆ  
  1. Ball Bearing เหมาะสมสำหรับแรงในแนวรัศมีภาระไม่สูงมากเกินไป  
  2. Roller Bearing เหมาะสมสำหรับแรงในแนวรัศมีภาระสูง  
  3. Thirst Bearing เหมาะสมสำหรับแรงในแนวแกนมีภาระไม่สูงเกินไป  
  การประเมินค่าอายุการใช้งานของแบริ่งทางสมาคม AFBMA ได้ตั้งนิยามและวิธีการ
เลือกใช้แบริ่งซึ่งมีดังต่อไปนี้  
  1) อายุแบริ่ง หมายถึง จานวนชั่วโมงที่ความเร็วคงที่ ซึ่งแบริ่งจะหมุนดุมได้ก่อนที่จะ
เกิดความล้าขึ้นในวงแหวน หรือลูกกลิ้ง  
  2) อายุประเมินของแบริ่ง หมายถึงจำนวนรอบ หรือจำนวนชั่วโมงที่ความเร็วคงที่ซึ่ง
แบริ่ง 90 เปอร์เซ็นต์ สามารถหมุนได้โดยไม่เกิดความเสียหายจากการล้า  
  3) แรงสถิตประเมิน หมายถึง แรงในแนวรัศมีที่ทำให้เกิดระยะยุบตัวของลูกกลิ้ง 
และวงแหวนรวมกันเท่ากับ 0.00001 เท่าของเส้นผ่าศูนย์กลางของลูกกลิ้ง  
  4) แรงพลวัตประเมิน หมายถึงแรงเนื่องจากการส่งกาลัง  
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2.5 กรรมวิธีผง (Powder Metallurgy) [5] 
 กรรมวิธีผง (Powder Metallurgy) เป็นกระบวนการขึ้นรูปชิ้นงาน โดยมีวัสดุตั้งต้นเป็นผง 
นำมาอัดให้ได้รูปทรงที่ต้องการแล้วนำไปให้ความร้อนแบบซินเตอร์ริ่ง (Sintering) คือ ให้ความความ
ร้อนโดยไม่มีการหลอมเหลว เพื่อให้ผงและส่วนผสมอ่ืนประสานติดกับเป็นชิ้นงานของแข็ง ซ่ึงกรรมวิธี
ผง มีข้ันตอนดังนี้ 

2.4.1 การผลิตผง (Powder production) 
2.4.2 การผสมผง (Blending) 
2.4.3 การอัด (Compaction) 
2.4.4 การให้ความร้อน (Sintering) 
2.4.5 กระบวนการระยะสุดท้าย (Finishing operations) 

 
2.6 การผสม (Mixing) [6] 
 การผสมเป็นการนำวัสดุต่างชนิดมารวมกันและให้เฉลี่ยเข้ากัน ได้แก่ การผสมสารเติมแต่งกับ
พลาสติก ซึ่งส่วนใหญ่เป็นการผสมของแข็งกับของแข็งหรือของแข็งกับของเหลวเข้าด้วยกันโดยใช้
เครื่องผสม (Mixer หรือ blender) โดยทำให้วัสดุเกิดการเคลื่อนที่กระแทก เสียดสี และคลุกเคล้า  
กันจนได้สภาพการผสมที่ต้องการ ด้วยการหมุนของใบกวนในถังเปิดหรือปิด ผลของการผสมทำให้เกิด
การกระจายตัวของวัสดุต่างชนิดกันเข้ากันอย่างทั่วถึง แต่ยังคงสามารถแยกอนุภาคของสารแต่ละชนิด
ได้อย่างชัดเจน เครื่องผสมที่ใช้ในการผสมมีลักษณะการผสมแบบรุ่น (Batch mixer) ซึ่งเกิดการผสม
โดยการทำให้วัสดุเกิดการเคลื่อนที่คลุกเคล้ากัน เทคนิคการผสมนี้สามารถแบ่งออกเป็น 2 แบบคือ 
การผสมแบบเย็น (Cold mixing) และการผสมแบบร้อน (Hot mixing) 
 2.6.1 การผสมแบบเย็น (Cold mixing) 
  เทคนิคการผสมแบบนี้เป็นการผสมจะเกิดขึ้นที่อุณหภูมิห้องสามารถใช้ผสมพลาสติก 
และสารเติมแต่งท่ีมีขนาดอนุภาคต่างกัน ตัวอย่างเครื่องผสมแบบผสมเย็น เช่น  
  2.6.1.1 เครื่องผสมแบบถังหมุน (Drum tumbler) เครื่องผสมแบบถังหมุนทำให้
เกิดการผสมของสารเติมแต่งชนิดต่างๆ กับพลาสติกเข้า ด้วยกัน โดยอาศัยแรงโน้มถ่วงและการหมุน
เหวี่ยงของถังหมุน ซึ่งแรงเหล่านี้มีผลต่อการเปลี่ยน ขนาดอนุภาคของสารต่างๆ เพียงเล็กน้อยเท่านั้น 
เครื่องผสมชนิดนี้มีหลายแบบ แต่แบบที่นิยมใช้ และราคาถูกที่สุด คือ เครื่องผสมแบบถังหมุนปกติ 
(Tumbling barrel) มักใช้สำหรับการผสมสารเติม แต่งปริมาณไม่มากลงในพลาสติก ประกอบด้วยถัง
ผสมขนาดประมาณ 130-210 ลิตรซึ่งถูกขับให้ หมุนด้วยมอเตอร์ไฟฟ้า ประสิทธิภาพการผสมขึ้นกับ
ปริมาณวัสดุและเวลาที่ใช้ในการผสม นอกจากนี้ยังมีเครื่องผสมแบบถังหมุนแบบอ่ืนๆ ที่ให้การผสม
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เข้ากันได้ดีกว่า เนื่องจากมีการหมุนและการเหวี่ยงของถังผสมในเวลาเดียวกัน เช่น ถังหมุนแบบ     
รูปตัววี (V-shape mixer) และถังหมุนแบบกรวยคู่ ( Double cone mixer) เป็นต้น 
   

 
 

รูปที่ 2.6 เครื่องผสมแบบถังหมุนแบบรูปตัววี (V-shape mixer) [6] 
 
  2.6.1.2 เครื่องผสมแบบริบบอน (Ribbon blender) เครื่องผสมแบบริบบอนมีตัว
กวนผสม ซึ่งมีลักษณะเป็นแผ่นโลหะขดวนคล้ายสปริงเรียกว่า ริบบอนบรรจุอยู่ในถังผสมที่ยึดติดอยู่
กับที่ แผ่นริบบอนนี้ถูกยึดติดกับเพลาขับที่สามารถหมุนด้วย ความเร็วประมาณ 20-60 รอบต่อนาที 
เครื่องผสมแบบนี้นิยมใช้ในการผสมวัสดุที่มีลักษณะเป็นผง หรือก้อนเล็กๆ โดยทั่วไปในขณะทำการ
ผสมจะไม่เกิดความร้อนขึ้น เนื่องจากขณะทำการผสมจะไม่ เกิดแรงเฉือนระหว่างวัสดุและระหว่างริบ
บอนกับผนังของถังผสม 
 
 
 
 
 
 

 
   

รูปที่ 2.7 เครื่องผสมแบบริบบอน (Ribbon blender) [6] 
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  2.6.1.3 เครื่องผสมแบบกรวยที่มีสกรูภายใน (Conical screw mixer) เครื่องผสม
แบบนี้ประกอบด้วยถังผสมที่มีลักษณะเป็นกรวยกลม และมีสกรูบรรจุอยู่ภายในถัง โดยวางแนบอยู่
ใกล้กับผนังของถังผสม สกรูนี้สามารถหมุนได้ 2 ลักษณะคือ หมุนรอบแกนสกรู และหมุนเคลื่อนที่ใน
แนวเส้นรอบวงของถัง ความเร็วในการหมุนสามารถปรับเปลี่ยนได้ เครื่องผสมแบบนี้สามารถผสมสาร
ที่มีปริมาณเล็กน้อยได้อย่างมีประสิทธิภาพ 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 2.8 เครื่องผสมแบบกรวยที่มีสกรูภายใน (Conical screw mixer) [6] 
 

 2.6.2 การผสมแบบร้อน (Hot mixing)  
  เทคนิคการผสมแบบนี้มีการให้ความร้อนแก่วัสดุที่ทำการผสม โดยอุณหภูมิของห้อง
ผสมอาจสูงถึง 140 องศาเซลเซียส ดังนั้นสารเติมแต่งบางชนิดอาจหลอมแล้วกระจายตัวเข้าไป 
ตัวอย่างเครื่องผสมแบบนี้ ได้แก่ เครื่องผสมเทอร์บูแลนท์ (Turbulent mixer) ซึ่งประกอบด้วยถัง
ผสมร้อน และถังหล่อเย็น ภายในถังผสมร้อนมีใบพัดกวนที่มีความเร็วสูงเป็นตัวช่วยในการผสม
องค์ประกอบต่างๆ เข้าด้วยกัน หลังจากผสมกันแล้วจะถ่ายของผสมร้อนลงในถังหล่อเย็น           
เพ่ือทำให้ของผสมร้อนเย็นตัวลงเหลือประมาณ 35 องศาเซลเซียส ระยะเวลาผสมของเครื่องผสมแบบ
นี้จะใช้เวลาสั้นมาก คือ ประมาณ 10 นาทีต่อครั้ง ขนาดของเครื่องผสมร้อน โดยทั่วไปอยู่ระหว่าง 
1,000-1,500 ลิตร และเครื่องผสมเย็นประมาณ 2,000-3,000 ลิตร 
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2.7  พอลิเอทิลีน (Polyethylene) [7] 
 พอลิเอทิลีนหรือที่ เรียกกันสั้นๆว่า PE คือสารที่ เป็นส่วนผสมของการขึ้นรูปพลาสติก            
ที่สามารถขึ้นได้ทั้งแบบแข็งและแบบอ่อน มีสีขาวขุ่นโปร่งแสง มีความลื่นมันในตัวเอง เมื่อสัมผัสจึง 
รู้สึกลื่นยืดหยุ่นได้ดี และที่สำคัญไม่มีกลิ่นและรส แถมยังไม่ติดแม่พิมพ์อีกด้วย มีความเหนียว        
แต่ทนความร้อนได้ไม่มากนัก มีความหนาแน่นอยู่ 3 ระดับด้วยกันคือ 
 2.7.1 พอลิเอทิลีนความหนาแน่นต่ำ (LDPE) มีความหนาแน่นอยู่ในช่วงตั้งแต่ 0.91 ถึง 0.93 
กรัมต่อลูกบาศก์เซนติเมตร โมเลกุลของ LDPE มีแบ็กโบนคาร์บอนที่มีไซด์กรุ๊ปของคาร์บอนสี่ถึงหก
อะตอมติดกับแบ็กโบนหลักอย่างสุ่มๆ LDPE มีการใช้อย่างกว้างขวางเพราะว่าไม่แพง ยืดหยุ่นได้ 
ทนทานมากและทนต่อสารเคมี LDPE ถูกขึ้นรูปเป็นขวด หีบห่ออาหาร และของเล่น 
 2.7.2  พอลิเอทิลีนความหนาแน่นปานกลาง (MDPE) มีความหนาแน่นอยู่ในช่วงตั้งแต่   
0.93–0.95 กรั ม ต่ อ ลู ก บ าศ ก์ เซน ติ เม ต ร  MDPE ส าม ารถผลิ ต  โด ย โค ร เมี ย ม  catalysts,         
Ziegler-Natta catalysts หรือ metallocene catalysts MDPE มีดีช็อกและปล่อยความต้านทาน
คุณสมบัตินอกจากนี้เป็นรอยเว้าน้อย มีความสำคัญกว่า HDPE 
 2.7.3 พอลิเอทิลีนความหนาแน่นสูง (HDPE) มีความหนาแน่นอยู่ในช่วงตั้งแต่ 0.95 ถึง 0.97 
กรัมต่อลูกบาศก์เซนติเมตร โมเลกุลของ HDPE จะมีแบ็กโบนคาร์บอนที่ยาวมากแต่ไม่มีไซด์กรุ๊ป ผลก็
คือ โมเลกุลเหล่านี้เชื่อมกันอย่างแน่นหนามากข้ึน HDPE แข็งแรงกว่า แข็งกว่า และโปร่งแสงน้อยกว่า
พอลิเอทิลีนความหนาแน่นต่ำ HDPE ใช้ทำถุง ถังน้ำมันรถ หีบห่อและท่อน้ำ  
 

 
 

รูปที่ 2.9 ผงพอลิเอทิลีน (Polyethylene Powder) [8] 
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2.8  อลูมินา (Alumina) [9] 
 อลูมินามีชื่อทางเคมีว่า อลูมิเนียมออกไซด์ สูตรทางเคมีคือ Al2O3 พบในธรรมชาติในรูปของ
แร่คอรันดัม (corundum) โดยปกติจะมีสีขาวหรือไม่มีสี แต่หากมีสิ่งเจือปนในโครงสร้างของอลูมินา
เล็กน้อย จะทำให้เกิดสีต่าง ๆ ทำให้มีความสวยงามมากขึ้น กลายเป็นแร่ที่มีค่า เช่น สีแดงของทับทิม
เกิดจากมีธาตุโครเมียมอยู่ในเนื้ออลูมินา เป็นต้น โครงสร้างของอลูมินาประกอบด้วยพันธะระหว่าง
อะลูมิเนียมกับออกซิเจนที่มีความแข็งแรงมาก การทำลายพันธะดังกล่าว ต้องใช้พลังงานสูง            
ทำให้อลูมินามีความแข็งมาก โดยวัสดุที่แข็งแรงมากกว่าอลูมินา มีเพียงเพชรเท่านั้น นอกจากนั้นแล้ว 
อลูมินายังทนความร้อนและการกัดกร่อนจากสารเคมีชนิดต่างๆ ได้ดีอย่างยิ่ง และมีสมบัติเป็น
ฉนวนไฟฟ้าที่ดีอีก 
 
  
  
 
 
 
 
 
 
 
 
 

รูปที่ 2.10 ผงอลูมินา (Alumina Powder) [10] 
 

อลูมินาที่ใช้ในอุตสาหกรรม ผลิตขึ้นจากแร่ออกไซต์ โดยกระบวนการที่มีชื่อว่ากระบวนการ
ของเบเยอร์ เพ่ือกำจัดสิ่งเจือปน และเปลี่ยนอลูมิเนียมไฮดรอกไซด์ให้เป็นอลูมินา อลูมินาที่ผลิตได้
ส่วนใหญ่ (มากกว่าร้อยละ 90) ใช้เป็นสารตั้งต้นในการผลิตโลหะอลูมิเนียม ส่วนที่เหลืออีกประมาณ
ร้อยละ 10 นำไปใช้ในรูปของอลูมินาโดยตรง 
 ประโยชน์ของอลูมินามีมากมาย นอกจากจะใช้เป็นส่วนผสมในผลิตภัณฑ์เซรามิกเพ่ือให้เกิด
ความแข็งแรงมากขึ้นแล้ว ยั งสามารถนำไปขึ้นรูป เป็นผลิตภัณฑ์ที่ มีประโยชน์หลายชนิด              
เช่น ใช้ทำวัสดุทนไฟในเตาเผาและเตาหลอม วัสดุขัดถู ลูกบดและผนังกรุหม้อบดสำหรับอุตสาหกรรม
เซรามิก ถ้วยเผาสาร (crucible) สำหรับอุตสาหกรรมอัญมณี หัวพ่นทรายสำหรับงานตกแต่งผิวโลหะ 
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แผ่นรองวงจรไฟฟ้ารวม (IC) สำหรับอุตสาหกรรมอิเล็กทรอนิกส์ หัวเทียนสำหรับอุตสาหกรรมยานยน
ใช้ทำฝาครอบหลอดไฟโซเดียมที่ ให้ความสว่างสูง และยังใช้เป็นชิ้นส่วนของ อวัยวะทดแทน         
เช่น ข้อต่อกระดูกเทียม เป็นต้น จากการสำรวจของกระทรวงการค้าต่างประเทศและอุตสาหกรรม 
ของญี่ปุ่น (MITI) ในปี 1997 พบว่าเฉพาะที่ญี่ปุ่นประเทศเดียว ตลาดผลิตภัณฑ์อลูมินาก็มีมูลค่าถึง
เกือบ 2.5 แสนล้านเยน หรือประมาณ 1 แสนล้านบาท จึงนับได้ว่าเป็นวัสดุที่มีศักยภาพทางการตลาด
ที่น่าสนใจมากชนิดหนึ่ง 
 
2.9  โปรแกรม Image J [11] 
 Image J เป็นโปรแกรมที่ได้ถูกพัฒนาขึ้นในประเทศสหรัฐอเมริกาโดย The National 
Institute of Health (NIH) โปรแกรมนี้ถูกเขียนมาเพ่ืออำนวยความสะดวกในการวิเคราะห์ข้อมูลจาก
รูปภาพ ตัวอย่างเช่น การนับจำนวนเซลล์ที่ได้จากภาพถ่าย การหาพ้ืนที่ของวัตถุ เป็นต้น โดยทำการ
วัดขนาดของอนุภาคที่ปรากฏในรูปภาพ นอกจากนี้ยังได้มีการพัฒนามาเพ่ือวิเคราะห์ขนาดของเกรน
และการกระจายตัวของภาคตัดขวางของวัสดุ เป็นการประยุกต์ใช้เพ่ือหาคุณสมบัติของวัสดุอีกวิธีหนึ่ง 
ปัจจุบันได้มีการนำมาใช้มากขึ้นในการวิเคราะห์ทางวิทยาศาสตร์  
 โปรแกรมสามารถทำงานได้โดยมีคำสั่ง Analyze,Process และคำสั่งอ่ืน และสามารถบันทึก
ไฟล์ในรูปแบบ 8-bit,16-bit,32-bit และไฟล์ที่ตัวโปรแกรมอ่านได้ต้องบันทึกด้วยนามสกุลเหล่านี้คือ 
TIFF,GIF,JPEG,BMP,DICOM,FITS และ raw และตัวโปรแกรมสามารถเปิดภาพเพ่ือใช้ในการ
วิเคราะห์พร้อมๆกันหลายภาพได้ในเวลาเดียวกัน และสามารถคำนวณ Fraction Area หรือสัดส่วน
พ้ืนที่ และสามารถหาพ้ืนที่ในการวัดได้ สามารถหาค่าได้ทั้งในหน่วยพ้ืนที่ เช่น ตารางมิลลิเมตร หรือ 
ค่าในหน่วย pixel ของรูปนั้น สามารถจัดทำค่าต่างๆในรูปสถิติได้ วัดระยะความยาวของเซลล์ วัด
ความหนาแน่นของรูปภาพแล้วแสดงในรูปแบบแผนภูมิแท่งหรือ Histograms และยังสนับสนุน 
Function ต่างๆ 
 
 
 
 
 
 
 
 
 



21 
  
2.10  งานวิจัยท่ีเกี่ยวข้อง 
 นายเศรษฐ์ศักดิ์ ณ ลำปาง และคณะผู้จัดทำเครื่องผสมปุ๋ยและอาหารสัตว์จากสถาบัน
เทคโนโลยีราชมงคลวิทยาเขตภาคพายัพ  จังหวัดเชียงใหม่ เป็นผู้ประดิษฐ์คิดค้นเครื่องผสมปุ๋ย      
และอาหารสัตว์มีขนาด 800 x 950 x 1350 มิลลิเมตร มีชุดเพลาผสมหมุนอยู่ภายในถังทรงกระบอก
แนวนอนขนาดเส้นผ่าศูนย์กลาง 450 มิลลิเมตร ยาว 800 มิลลิเมตร ใช้กำลังมอเตอร์ไฟฟ้าขนาด  
746 วัตต์ เฟสเดียวเป็นต้นกำลัง ส่งกำลังผ่านสายพานลิ่มไปยังเกียร์ทดรอบในอัตราทด 3 : 4 โดย
เกียร์ทดรอบมีอัตราทด 1:20 ส่งกำลังไปยังเพลาผสมโดยโซ่ส่งกำลัง อัตราทด 1:2 ได้ความเร็วรอบที่
เพลาผสมประมาณ 27 รอบ/นาท ีสามารถผสมปุ๋ยและอาหารสัตว์ได้ครั้งล่ะ 50 กิโลกรัม 
 ทรงกลด จารุสมบัติ จากมหาวิทยาลัยเกษตรศาสตร์ ได้ทำการออกแบบและจัดสร้างเครื่อง
ผสมวัสดุทดแทนไม้กับกาว เครื่องสามารถผสมวัสดุทดแทนไม้จาพวกเศษวัสดุเหลือใช้จากการเกษตร 
เช่น ซังข้าวโพด ชานอ้อย เครื่องมีขนาด 1,520 x 2,400 x 1,936.25 มิลลิเมตร เส้นผ่าศูนย์กลางของ
ตัวถัง 1,110 มิลลิเมตร ต้นกำลังเป็นมอเตอร์ไฟฟ้า 220 โวลท์ ขนาด 5 แรงม้า ตัวถังอยู่กับที่ใช้ใบ
กวนในตัวถังเป็นตัวผสม กำลังการผลิตใช้ผสมต่าสุดที่ 10 กิโลกรัมและสูงสุดไม่เกิน 30 กิโลกรัม 
ขนาดของแผ่นวัสดุที่ได้ 6 x 9 ฟุต ซึ่งจะขึ้นอยู่กับวัสดุที่นำมาผสม  
 นายวราวุธ อ้ิมทับ และคณะจากมหาวิทยาลัยเทคโนโลยีราชมงคลล้านนาตากเป็นผู้ออกแบบ
และจัดสร้างเครื่องผสมครีมสมุนไพร ซึ่งมีหลักการทำงานคือ ใช้มอเตอร์ไฟฟ้ากระแสสลับขนาด    
3/4 แรงม้า 220 โวลต์ มีความเร็วรอบ 2,730 รอบต่อนาทีโดยมีชุดควบคุมมอเตอร์จำนวน 1 ชุด
สามารถปรับความเร็วรอบได้และส่งกำลังผ่านแกนเพลาโดยตรง และแกนเพลาจะมีใบพัดและชุดหัว
กวนติดอยู่ เพ่ือทำหน้าที่ผสมเนื้อครีมเข้าด้วยกันการทำงานของเครื่องผสมครีมสมุนไพรสามารถผสม
ครีมได้ในจำนวนครั้งละ 30 ลิตร ได้เนื้อครีมที่ละเอียดให้ส่วนผสมเป็นเนื้อเดียวกัน และยังสามารถลด
ฟองอากาศในขั้นตอนการผสมอีกด้วย ดังรูปที ่2.12 
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รูปที ่2.11 เครื่องผสมครีมสมุนไพร 
 

 สาธิต สอนแก้ว และคณะ จากมหาวิทยาลัยเทคโนโลยีราชมงคลล้านนาตาก เป็นผู้ออกแบบ
และสร้างเครื่องผสมผงยาสมุนไพร ซึ่งหลักการทำงานของเครื่องคือใช้มอเตอร์ไฟฟ้ากระแสสลับขนาด 
1/4 แรงม้า 220 โวลต์มีความเร็วรอบ 1450 รอบต่อนาที ส่งกำลังไปยังเกียร์ทดรอบที่ 1:60 แล้วส่ง
กำลังไปยังเพลาหมุนถังผสมผงยาสมุนไพรรูปทรงวีที่  25 รอบต่อนาที  ผสมผงยาสมุนไพร            
ครั้งละ  2 กิโลกรัม เครื่องผสมผงยาสมุนไพรที่ผู้ผลิตผลิตขึ้นได้เนื้อยาและสีของยาที่ผสมได้ตามที่
ต้องการของผู้เชี่ยวชาญต้องใช้รอบในการหมุนถังผงยาสมุนไพรที่ 450 รอบ ดังรูปที่ 2.13 
 

 
 

รูปที ่2.12 เครื่องผสมครีมสมุนไพร 
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บทที่ 3 
 

การคำนวณและการออกแบบ 
 
 ในบทนี้จะกล่าวถึงการคำนวณและการออกแบบเพ่ือให้บรรลุวัตถุประสงค์ โดยได้กำหนดวิธีการ 
ดำเนินการศึกษาให้สอดคล้องกับวัตถุประสงค์ท่ีได้นำเสนอไว้ในบทที่ 1 โดยมีรายละเอียดดังนี้ 
 
3.1  การออกแบบข้ันตอนการดำเนินโครงการ 
  

 
 

รูปที่ 3.1 แผนภูมิการดำเนินการสร้างเครื่องผสมผงวัสดุแบบ V-blender
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ในการดำเนินการสร้างเครื่องผสมผงวัสดุ V-blender นั้น มีลำดับขั้นตอนดังนี้ 
 3.1.1 ศึกษาทฤษฏีและหลักการทำงาน ศึกษาทฤษฎีที่เกี่ยวข้องในขั้นตอนนี้ได้ศึกษาทฤษฎี
ต่างๆ เกี่ยวกับหลักการทำงานของเครื่องผสม ผงวัสดุ หลักการออกแบบชิ้นส่วนผสมผงวัสดุ และการ
เลือกใช้วัสดุทำชิ้นส่วนที่สำคัญโดยได้รวบรวมข้อมูลจาก เอกสารและตำราที่เกี่ยวข้องต่างๆ เพ่ือ
นำมาใช้เป็นข้อมูลการออกแบบให้สมบูรณ์ที่สุด 
 3.1.2 ออกแบบเครื่องผสมผงวัสดุ V-blender แนวทางในการออกแบบในแต่ละขั้นตอนจะเน้น
หลักการทำงานง่ายๆ ในการทำงานของชิ้นส่วนต่างๆ โดยในที่นี้เพ่ือให้สามารถสร้างชิ้นส่วนขึ้นเองได้ 
ไม่จำเป็นต้องใช้เครื่องมือที่พิเศษในการผลิตชิ้นส่วนรวมทั้ง พยายามใช้วัสดุที่สามารถหาได้ง่าย หรือมี
ขายตามท้องตลาดทั่วไป 
 3.1.3 จัดเตรียมวัสดุอุปกรณ์ท่ีใช้ในการทำโครงงาน โดยมีขั้นตอนการเลือกซื้อวัสดุดังนี้ 
  3.1.3.1 วัสดุที่นำมาผลิตต้องขึ้นรูปได้ง่ายเหมาะสมแก่การใช้งาน  
   3.1.3.2 ใช้วัสดุที่จำหน่ายในท้องตลาดทั่วไป 
  3.1.3.3 เป็นชิ้นส่วนมาตารฐาน 
  3.1.3.4 สามารถปรับปรุงแก้ไขและบำรุงรักษาได้ง่าย 
  3.1.3.5 ความแตกต่างด้านราคาวัสดุซื้อหาได้ง่ายราคาไม่แพง 
 3.1.4 สร้างเครื่องผสมผงวัสดุ V-blender การสร้างได้ทำการจัดแยกชิ้นส่วนแต่ละชิ้นพร้อมกับ
รายละ เอียดของชิ้นส่วนทั้งหมด โดยแบ่งออกเป็นชิ้นส่วนต่างๆ ที่สำคัญดังต่อไปนี้ 

1) โครงสร้าง 
2) ระบบส่งกำลัง 
3) ถังผสม 

 3.1.5 ดำเนินการทดสอบการผสม โดยจะแบ่งขั้นตอนเป็นผ่านกับไม่ผ่าน ถ้าผ่านจะเข้าสู่ขั้นตอน
ต่อไป ส่วนถ้าไม่ผ่านจะเข้าสู่ขั้นตอนปรับปรุงแก้ไขจนกว่าจะผ่านและดำเนินการทดสอบการ ผสมอีก
ครั้ง โดยผู้จัดทำโครงการได้พ้ืนที่ การทดลองที่ห้องปฏิบัติการ อาคารวิทยาศาสตร์ มหาวิทยา ลัยราช
มงคลพระนครเหนือ  
 3.1.6 เก็บข้อมูลและสรุปผล โดยเนื้อหาในข้อนี้จะอยู่ในบทถัดไป 
 3.1.7 ขั้นตอนสุดท้ายจะเป็นการจัดทำเล่มปริญญานิพนธ์ โดยจะต้องผ่านการตรวจสอบจาก
อาจารย์ ที่ปรึษา และผ่านการตัดสินผลสอบของคณะอาจารย์และคณะกรรมการ 
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รูปที่ 3.2 แสดงส่วนประกอบของเครื่องผสมผงวัสดุแบบ V-blender 
 

ตารางท่ี 3.1 แสดงส่วนประกอบของเครื่องผสมผงวัสดุแบบ V-blender 
 

No. ชื่อชิ้นส่วน จำนวน 
1 ถังผสมผงวัสดุ V-blender 1 
2 โครงเครื่อง 1 
3 สวิตช์ควบคุมและหน้าจอมอนิเตอร์ 1 
4 มอเตอร์ 1 
5 ชุดส่งกำลัง 1 
6 ตลับลูกปืน 2 
7 ชุดฝาปิดโครงเครื่อง 1 
8 แผ่นเหล็กรองฐาน 2 
9 ยางรอง 6 
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3.2 การคำนวณและการออกแบบ 
 การคำนวณและการออกแบบชิ้นส่วนบางชิ้นที่ไม่มีจำหน่ายในท้องตลาด จึงต้องเลือก ใช้ส่วนที่
เป็นมาตรฐานสากล เพ่ือให้ง่ายต่อการจัดหาชิ้นส่วนที่จำเป็นต้องนำมาประกอบและออกแบบเครื่อง
โดยโปรแกรม Solidworks 

 

 

รูปที่ 3.3 แสดงชุดส่งกำลังของเครื่องผสมผงวัสดุแบบ V-blender 
 
 
 3.2.1  คำนวณที่เก่ียวข้อง 
 1. การคำนวณหาน้ำหนักกระทำบนเพลา โดยจะนำถังผสมขนาด 2 ลิตร ซึ่งจะบรรจุผงอลูมิน่า
ไปชั่งน้ำหนัก เนื่องจากผงเป็นมวลที่มีรูพรูน น้ำหนักท่ีชั่งไม่สามารถเป็นค่าท่ีแน่นอนได้  
 การคำนวณเป็นแบบ Statics คือเป็นการคำนวณวัตถุที่หยุดนิ่งไม่เคลื่อนไหว และไม่ได้คำนวณ 
ถึงแรงหนีศูนย์เนื่องจากความเร็วรอบท่ีใช้เป็นความเร็วต่ำ  
 

W = mg   (3.1) 

 โดย 

  W   = น้ำหนักท่ีกระทำบนเพลา หน่วยเป็น นิวตัน 
  m   =  มวลทั้งหมดของถังผสมขนาด 2 ลิตร เท่ากับ  4.6 kg 

เพลาตาม เฟืองตาม 

มอเตอร ์ เฟืองขบั 
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  g =  แรงโน้มถ่วงของโลกเป็นค่าคงที่เท่ากับ 9.81 m/s2 

 แทนค่าในสมการ (3.1)  
W (4.6 kg)(9.81 m/s)=   

W 45.126 N=
  

  
 2. หาขนาดของเพลาแกนถังผสม 
 โดยจะกำหนดความยาวของเพลาแกนถังผสมตามความเหมาะสมเท่ากับ 113.18 mm และเส้น
ผ่านศูนย์กลางภายนอกต่อเส้นผ่านศูนย์กลางภายในเท่ากับ 1.5 ( Do / Di = 1.5 ) โดยจะใช้สูตรใน
การคำนวณดังนี้ 
 - ความเค้นดัด  

MC

I
 =  (3.2) 

 
 หาค่าต่างๆในสมการ (3.2) 
  M  =  F L  =  (45.126 N)(113.18 mm)   

   =  5,107.36 N.mm   

  C  =  o id 1.5d
0.75di

2 2
= =  

  I =  4 4 4 4
o i i o(d -d ) (1.5d -d )

64 64

 
 =   

   =  
4

4i
i

4.0625 d
= 0.1994d

64


 

 

 แทนค่าในสมการ (3.2) 

  i
4

(5,107.36)(0.75d )

0.1994d
 =  =  

3

3
i

19.21x10

d
 2N/mm  

- ความเค้นเฉือน 
Tr

J
 =  (3.3) 
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 หาค่าต่างๆในสมการ (3.3) 
  T  =  F r  =  oF(d /2)  =  i(45.126 N)(1.5d /2)  

   =  i33.844d  N.mm 

  r  =  o id 1.5d
= = 0.75di

2 2
 

  J  =  4 4 4 4
o i i o(d - d ) (1.5d - d )

32 32

 
 =   

   =  
4

4i
i

4.0625 d
0.3988d

32


=  

 

 แทนค่าในสมการ (3.3) 

  i i
4
i

(33.844d )(0.75d )

0.3988d
 =  =  2

i

63.65

d
 

 
 - ความเค้นเฉือนสูงสุด 

( )
1/22

21 2
max

-

2 2

  
 

 
= = + 

 
 (3.4) 

  

จาก      max   =   y

y2N


    (3.5) 

 

 ซึ่งค่า y  หาได้จากตารางที่ ก.2  

  y    =    35 ksi 

     =    35   6.895  =   241.325  
2N/mm  

  
 และค่า Ny หาได้จากตารางที่ ก.1 จากลักษณะการใช้งานจะเลือกใช้ค่า yN  =  3 

 แทนค่าต่างๆในสมการ (3.5) 
 

    max   =    
32

325.241

x
 =  40.22 2N/mm  
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 แทนค่าในสมการ (3.4) 

  

1/22 23

3 2
i i

19.21x10 63.65
40.22 = +

2d 2d

    
    
    

 

   

     
3

3 2
i i

9.605x10 31.82
40.22 = +

d d
 

  
 การแก้สมการนี้ทำได้โดยการทดลองแทนค่า di ซึ่งได้ว่า di =  6.2 mm  และ do =  9.3 mm 

เนื่องจากไม่สามารถหาท่อสแตนเลสขนาดดังกล่าวได้ จึงใช้ท่อสแตนเลสที่สามารถหาซื้อได้ง่าย มี
ขนาดเส้นผ่านศูนย์กลางภายนอก 30 mm และเส้นผ่านศูนย์ภายใน 20 mm 
 
 3. หาขนาดของมอเตอร์ 
 มอเตอร์จะส่งถ่ายกำลังผ่านชุดส่งกำลังโดยกำหนดอัตราทดเท่ากับ 3:1 ซึ่งความเร็วรอบ สูงสุด
ของถังผสมเท่ากับ 50 รอบ/นาที ฉะนั้นมอเตอร์จะหมุนด้วยความเร็วรอบสูงสุดเท่ากับ 150 รอบ/
นาที โดยจะใช้สมการการคำนวณดังนี้ 

2 NT
P

60


=  (3.6) 

 โดย 
  T  =  F r  =  (45.126 N)(0.015 m)  

   =  0.677 N.m  
  
 แทนค่าต่างๆในสมการ (3.6) 

  P  =  
2 (150)(0.677)

60


 =  10.63 W  

  
 เนื่องจากไม่สามารถหามอเตอร์ขนาดดังกล่าวได้ จึงใช้มอเตอร์ที่สามารถหาซื้อได้ง่าย โดยเป็น
มอเตอร์ขนาด 60 W 12 VDC 
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3.2 การผลิตชิ้นส่วนที่สำคัญของเครื่องผสมผง V-blender ตามที่ได้ออกแบบไว้ 
 3.2.1 เตรียมการขึ้นรูปถังผสมผง โดยถังผสมขนาด 1 และ 2 ลิตร นำท่อขนาดเส้นผ่านศูนย์ 
กลางภายนอกและภายใน 90 , 86 mm ตัดทำมุม 45 องศา ซึ่งทำจากเหล็กกล้าไร้สนิม 304 AISI  
 

 
 

รูปที่ 3.4 เตรียมการขึ้นรูปถังผสมผง 
 

 3.2.2 เชื่อมและตรวจสอบรอยเชื่อมของถังผสมผง โดยนำท่อประกอบและเชื่อมเข้าด้วยกัน ซึ่ง
จะเพ่ิมสกรูไว้ที่ปากถังผสมจำนวน 3 ตัว ไว้สำหรับล๊อคฝาปิดถังผสม 
 

 
 

รูปที่ 3.5 เชื่อมและตรวจสอบรอยเชื่อมของถังผสมผง 
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  3.2.2 ตรวจสอบขนาดของถังผสมผง ให้เป็นไปตามแบบที่กำหนดไว้ 
 

 
 

รูปที่ 3.6 ตรวจสอบขนาดถังผสมผง 
 

  3.2.3 เชื่อมและตรวจสอบรอยเชื่อมของโครงเครื่อง ซึ่งจะประกอบด้วยเหล็กกล่องขนาด 
25x25 mm หนา 2 mm โดยจะมีขนาดของโครงเครื่องเท่ากับ กว้างxยาวxสูง 300x600x275 mm 

 

 
 

รูปที่ 3.7 เชื่อมและตรวจสอบรอยเชื่อมของโครงเครื่อง 
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  3.2.4 ติดตั้งมอเตอร์และเพลา โดยเป็นมอเตอร์ขนาด 60W 12VDC 150 RPM และเพลา
ขนาดเส้นผ่านศูนย์กลาง 20 mm ยาว 400 mm  
 

 
 

รูปที่ 3.8 ติดตั้งมอเตอร์และเพลา 
 

  3.2.5 ติดต้ังชุดส่งกำลัง เป็นชุดกำลังด้วยโซ่โดยประกอบด้วยล้อเฟืองขับ 9 ฟันและล้อ
เฟืองตาม 27 ฟัน 
 

 
 

รูปที่ 3.9 ติดตั้งชุดส่งกำลังด้วยโซ่ 
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  3.2.7 ติดตั้งระบบควบคุมมอเตอร์ ประกอบด้วยปุ่มสตาร์ท (Start) ,หยุด (Stop) ,ตัวตั้ง
เวลา ,ตัวปรับความเร็วรอบและหลอดไฟแสดงสถานะ 
 

 
 

รูปที่ 3.10  ติดตั้งระบบควบคุมมอเตอร์ 
 
  3.2.5 ตรวจเช็คเครื่องผสมผงวัสดุแบบ V-blender ที่ประกอบเสร็จแล้ว 
 

 
 

รูปที่ 3.11 ตรวจเช็คเครื่องผสมผงวัสดุแบบ V-blender ที่ประกอบเสร็จแล้ว 
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บทที ่4 

การทดลองและผลการทดลอง 

 จากการกำหนดขั้นตอนการดำเนินงานในบทที่ผ่านมา ในบทนี้คณะผู้จัดทำได้ทำการทดลอง
การผสม ผง และทดสอบประสิทธิภาพของเครื่องผสมผง V-blender สามารถแบ่งเป็นหัวข้อได้ดังนี้  
  4.1 อุปกรณ์ที่ใช้ในการทดลอง  
  4.2 ขั้นตอนการทดลอง 
  4.3 ขั้นตอนการวิเคราะหผ์งโดยใช้โปรแกรม imagej 
  4.4 ผลการทดลอง  
  4.5 สรุปผลการทดลอง  
 
4.1 อุปกรณ์ที่ใช้ในการทดลอง  

 โดยการทดลองจะใช้ถังผสมผงขนาด 1 ลิตร ซึ่งทั่วไปแล้วในการผสมผงของเครื่องผสมผง
วัสดุ V-blender ถังที่ใช้ผสมผงจะประกอบด้วยผง 60% และที่เหลือ 40% เป็นพ้ืนที่ว่าง เพ่ือให้ถัง
ผสมเหลือเนื้อที่ว่างในการทำให้ผงทั้ง 2 ชนิด คลุกเคล้าผสมกันเป็นเนื้อเดียวกัน ฉะนั้นปริมาตรผงทั้ง 
2 ชนิด มีปริมาตรทั้งหมด 600 ml และจำเป็นต้องใช้อุปกรณ์ในการทดลองดังนี ้
 

 4.1.1 ผงทดลอง เป็นผงพอลิเอทิลีน(UHMWPE) และผงอลูมิเนียมออกไซค(์Al2O3) 
 

 
 

รูปที่ 4.1 ผงพอลิเอทิลีน(ซ้าย) และอลูมเินียมออกไซค์(ขวา) 
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4.1.2 เครื่องชั่งน้ำหนัก โดยค่าที่ออกมาเป็นหน่วย กรัม (g) 
   

 
 

รูปที่ 4.2 เครื่องชั่งน้ำหนัก 

 

 4.1.3 บีกเกอร์ มีบีกเกอร์ 3 ขนาดคือ 100 ml 600 ml 1000 ml  
 

 
 

รูปที่ 4.3 บีกเกอร์ใช้บรรจุผง 



37 
 

 4.1.4 กล้องส่องผง โดยตั้งระยะห่างจากพ้ืน 3 mm 
 

 
 

รูปที่ 4.4 กล้องส่องผง 

  

 4.1.5 จานแก้วใส่ผง (Watch glass) 
 

 
 

รูปที่ 4.5 จานแก้วใส่ผง (Watch glass) 
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 4.1.6 โปรแกรม Image J 

 
 

รูปที่ 4.6 โปรแกรม Image J 

 
4.2 ขั้นตอนการทดลอง  
 4.2.1 เตรียมผงวัสดุ เนื่องจากผงที่ใช้ในการทดลองมีสี เป็นสีขาวทั้งสองผง ทำให้การ
ตรวจสอบ ความเข้ากันของผงเป็นไปได้ยากจึงทำการผสมสีให้ต่างกัน โดยผงพอลิเอทิลีนผสมสีเป็นสี
ฟ้าและผงอลูมิเนียมออกไซค ์เป็นสีแดง 
 

 
 

รูปที่ 4.7 เตรียมผงพอลิเอทิลีนสีฟ้า(ซ้าย) และอลูมิเนียมออกไซค์สีแดง(ขวา) 
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 4.2.2 วัดปริมาตรและชั่งน้ำหนักของผงพอลิเอทิลีนและผงอลูมิเนียมออกไซค์  
 

 
 

 
 
 
 
 
 
 
 
 

 
รูปที่ 4.8 วัดปริมาตรและชั่งน้ำหนักของผงพอลิเอทิลีน(ซ้าย) และผงอลูมิเนียมออกไซค์(ขวา) 

  
 4.2.3 นำผงใส่ถังผสมผง โดยถังผสมผงเป็นถังปริมาตร 1ลิตร ซึ่งลำดับการใส่ผงนั้นจะใส่ผง 
อลูมิเนียมออกไซค์และตามด้วยใส่ผงพอลิเอทิลีน และจะใส่ผงทั้งสองคนละฝั่งของถังผสมผง 
 

 
 

รูปที่ 4.9 นำผงใส่ถังผสมผง 
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 4.2.4 เปิดสวิตช์อีเมอร์เจนซี่ (Emergency Switch) 
 

 
 

รูปที่ 4.10 เปิดสวิตช์อีเมอร์เจนซี่ 
 

 4.2.5 ปรับตั้งรอบที่ใช้ผสมผง โดยสเกลที่แสดงเป็นแบบเปอร์เซ็น ซึ่งวิธีปรับตั้งคือ  

(จำนวนรอบที่ต้องการx100)/50 
 

 
 

รูปที่ 4.11 ปรับตั้งรอบที่ใช้ผสมผง 
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 4.2.6 ปรับตั้งเวลาที่ใช้ผสมผง โดยจะมีเปลี่ยนตัวเลขตั้งแต่ 0-9 และเปลี่ยนหน่วยตั้งแต่ 

วินาที (S) , นาที (M) , ชั่วโมง (H) 
 

 
 

รูปที่ 4.12 ปรับตั้งเวลาที่ใช้ผสมผง 

 4.2.5 กดปุ่มสตาร์ท (Start) เพ่ือเดินเครื่อง 
 

 
 

รูปที่ 4.13 กดปุ่มสตาร์ท (Start) 
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 4.2.6 กดปุ่มหยุด (Stop) เมื่อถึงเวลาที่กำหนดไว้เพ่ือทำการรีเซ็ตเวลาที่ตั้งไว้ และกดปุ่ม 

สตาร์ทอีกครั้งเพื่อต้องการให้เครื่องทำงานต่อ 

 

 
 

รูปที่ 4.14 กดปุ่มหยุด (Stop) 
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4.3 ขั้นตอนการวิเคราะห์ผงด้วยโปรแกรม Image J 
 4.3.1 ต่อกล้องส่องผงกับคอมพิวเตอร์หรือโน๊คบุค 
 

 
 

รูปที่ 4.15 ต่อกล้องส่องผงกับคอมพิวเตอร์หรือโน๊คบุค 
 
 4.3.2 นำผงใส่ในจานแก้วใส่ผงแล้วถ่ายรูปผงและไม้บรรทัด 
 4.3.3 เปิดโปรแกรม Image J 
 

 
  

รูปที่ 4.16 โปรแกรม Image J 
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 4.3.4 เปิดรูปไม้บรรทัดที่ถ่ายไว้ ใช้คำสั่งสร้างเส้น ลากเส้นตั้งแต่ 1-5 mm 
 

 
 

รูปที่ 4.17 เปิดรูปไม้บรรทัด 
 

 4.3.4 เข้าคำสั่ง Analyze > Set scale เพ่ือกำหนดขนาดของภาพ 
 

 
 

รูปที่ 4.18 เข้าคำสั่ง Analyze > Set scale 
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 4.3.5 กำหนดขนาดของเส้น (Known distance) และกำหนดหน่วย (Unit of length) เลือก 
Global เพ่ือใช้กับทุกรูป จะเห็นว่าหน่วยของภาพเป็นเป็น pixels/mm และจะได้ ขนาดของภาพทั้ง 
หมดเป็น 12.24x6.89 mm  
 

 
 

รูปที่ 4.19 หน้าต่าง Set scale 
 
 4.3.6 เปิดรูปผงที่ถ่ายไว้ 
 4.3.7 เข้าคำสั่ง Image > Adjust > Color Threshold เพ่ือเลือกสีในการวิเคราะห์  
 

 
 

รูปที่ 4.20 เข้าคำสั่ง Image > Adjust > Color Threshold 
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 4.3.8 โดยจะอธิบายคำสั่งของ Color Threshold ดังนี้ 
  1. Hue คือ การกำหนดช่วงของสีที่เราต้องการ โดยจะเลือกช่วงประมาณ 139-199 
  (สีฟ้า-สีน้ำเงิน) 
  2. Saturation คือ การกำหนดช่วงความอ่ิมตัวของสี โดยจะเลือกช่วง 0-255 
  3. Brightness คือ การกำหนดช่วงของความสว่างของสี โดยจะเลือกช่วง 0-255 
  4. Thresholding method คือ รูปแบบการวิเคราะห์ โดยเลือกใช้ Default 
  5. Threshole color คือ พื้นที่สีที่เราเลือกให้เป็นสีอะไร โดยจะเลือกเป็นสีแดง 
  6. Color space คือ รูปแบบของสีที่จะกำหนด โดยจะเลือกเป็น HSB 
 

 
 

รูปที่ 4.21 หน้าต่างคำสั่ง Color Threshold 
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 4.3.9 เมื่อกำหนดพ้ืนที่สีที่จะวิเคราะห์เสร็จแล้ว ให้เลือกคำสั่ง Select จากนั้น โปรแกรมจะ
วงพ้ืนที่ที่เราเลือกไว้ให้  
 

 
 

รูปที่ 4.22 กำหนดพ้ืนที่สีที่จะวิเคราะห์ 
 
 4.3.10 เข้าคำสั่ง Analyze > Measure เพ่ือแสดงผลในการวิเคราะห์ของสี 
 

 
 

รูปที่ 4.23 เข้าคำสั่ง Analyze > Measure 
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 4.3.11 โปรแกรมจะแสดงข้อมูลต่างๆของสี โดยจะมี พ้ืนที่ (Area), ค่าเฉลี่ยของสี (Mean), 
ค่าต่ำสุดของสี (Min), ค่าสูงสุดของสี (Max) 

 

 
 

รูปที่ 4.24 หน้าต่างคำสั่ง Measure 
 
 4.3.12 นำค่าต่างๆมาใส่ในตาราง เพ่ือในมาวิเคราะห์ต่อไปในหัวข้อผลการทดลอง 
 
4.4 ผลการทดลอง 
 จาการทดลองเพ่ือหาประสิทธิภาพในการผสมผง โดยจะแบ่งการทดลองเป็น 3 รอบ รอบละ 
8 ครั้ง  แต่ละรอบจะเปลี่ยนอัตราส่วนผสมเป็น 2% , 5% และ 8% ที่ความเร็วรอบ 20 รอบ/นาที ซ่ึง
การทดลองทุกครั้งจะเก็บตัวอย่างการผสมและสรุปอยู่ในตารางที่ 4.1 - 4.3 โดยจะบอกรายละเอียด
ส่วนผสมดังนี้ 
 4.4.1 ผงอลูมิน่า–พอลีเอทีลีน โดยมีพอลีเอทีลีน 2%  
  - ผงอลูมิเนียมออกไซค์ 588 ml, 490 g (98%) 
  - ผงพอลีเอทีลีน 12 ml, 6.4 g (2%) 
 4.4.2 ผงอลูมิน่า–พอลีเอทีลีน โดยมีพอลีเอทีลีน 5%  
  - ผงอลูมิเนียมออกไซค์ 570 ml, 475 g (95%) 
  - ผงพอลีเอทีลีน 30 ml, 16 g (5%) 
 4.4.3 ผงอลูมิน่า–พอลีเอทีลีน โดยมีพอลีเอทีลีน 8%  
  - ผงอลูมิเนียมออกไซค์ 552 ml, 460 g (92%) 
  - ผงพอลีเอทีลีน 48 ml, 25.6 g (8%) 
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ตารางท่ี 4.1 ผลการทดลองอลูมิน่า–พอลีเอทีลีน โดยมีพอลีเอทีลีน 2% 

 

การทดลอง
ครั้งที่ 

เวลา 
(นาที) 

พื้นที่ทั้งหมด 
(mm2) 

พื้นที่สีฟ้า 
(mm2) 

ประสิทธิภาพ 
การผสม 

1 1 84.33 2.305 97.27% 
2 2 84.33 1.360 98.39% 
3 3 84.33 0.605 99.28% 
4 4 84.33 0.130 99.84% 
5 5 84.33 0.181 99.78% 
6 10 84.33 0.053 99.93% 
7 15 84.33 0.098 99.88% 
8 20 84.33 0.029 99.96% 

ประสิทธิภาพการผสมเฉลี่ย 99.29% 
 

 

      3 นาที             4 นาที 

     5 นาที            10 นาที 
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     15 นาที            20 นาที 

รูปที่ 4.25 ผลการทดลองอลูมิน่า–พอลีเอทีลีนโดยมีพอลีเอทีลีน 2% ตั้งแต่ 1-20 นาที 

 

ตารางท่ี 4.2 ผลการทดลองอลูมิน่า–พอลีเอทีลีน โดยมีพอลีเอทีลีน 5%  

 

การทดลอง
ครั้งที่ 

เวลา 
(นาที) 

พื้นที่ทั้งหมด 
(mm2) 

พื้นที่สีฟ้า 
(mm2) 

ประสิทธิภาพ 
การผสม 

1 1 84.33 33.239 60.58% 
2 2 84.33 8.963 89.37% 
3 3 84.33 6.861 91.86% 
4 4 84.33 6.226 92.62% 
5 5 84.33 2.498 97.04% 
6 10 84.33 1.722 97.95% 
7 15 84.33 1.212 98.56% 
8 20 84.33 0.926 98.90% 

ประสิทธิภาพการผสมเฉลี่ย 90.86% 
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     1 นาที           2 นาท ี

     3 นาที            4 นาที 

     5 นาที           10 นาท ี

 

   

 

 

 
      15 นาที         20 นาท ี

รูปที ่4.26 ผลการทดลองอลูมิน่า–พอลีเอทีลีนโดยมีพอลีเอทีลีน 5% ตั้งแต่ 1-20 นาที 
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ตารางท่ี 4.3 ผลการทดลองอลูมิน่า–พอลีเอทีลีน โดยมีพอลีเอทีลีน 8%  

 

การทดลอง
ครั้งที่ 

เวลา 
(นาที) 

พื้นที่ทั้งหมด 
(mm2) 

พื้นที่สีฟ้า 
(mm2) 

ประสิทธิภาพ 
การผสม 

1 1 84.33 35.892 57.44% 
2 2 84.33 21.659 74.31% 
3 3 84.33 9.169 89.13% 
4 4 84.33 5.300 93.72% 
5 5 84.33 8.140 90.35% 
6 10 84.33 3.983 95.28% 
7 15 84.33 1.332 98.42% 
8 20 84.33 0.724 99.14% 

ประสิทธิภาพการผสมเฉลี่ย 87.22% 
 

 

 
     1 นาที             2 นาที 

 

 

 

 

 

 

 

     3 นาที             4 นาที 
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       5 นาที           10 นาท ี

 

 
      15 นาที           20 นาท ี

รูปที่ 4.27 ผลการทดลองอลูมิน่า–พอลีเอทีลีนโดยมีพอลีเอทีลีน 8%  
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4.4 สรุปผลการทดลอง 

 จากตารางที่ 4.1-4.3 จะพบว่าถ้าเพ่ิมอัตราส่วนผสมจะทำให้ประสิทธิภาพการผสมลดต่ำลง

มากในนาทีแรกและจะเพ่ิมข้ึนเมื่อเวลาผ่านไป ซึ่งประสิทธิภาพจะใกล้เคียงกันเวลาประมาณ 5-20 

นาท ี

 

 
 

รูปที ่4.28 ประสิทธิภาพต่อเวลาการผสม  

  

 จากตารางที่ 4.1 - 4.3 ที่เวลา 20 นาที ความรอบ 20 รอบ/นาที พบว่าประสิทธิภาพสูงสุด

ของเครื่องผสมผงไม่ถึง 100% จึงทำการหาประสิทธิภาพสูงสุดโดยใช้ความเร็วรอบสูงสุดของเครื่อง

ผสมที่ 50 รอบ/นาที เพ่ือให้ทราบว่าประสิทธิภาพสูงสุดการผสมถึง 100% ได้หรือไม่  
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ตารางท่ี 4.4 ผลการทดลองอลูมิน่า–พอลีเอทีลีน โดยมีพอลีเอทีลีน 8% ที่ความรอบ 50 รอบ/นาที 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

รูปที ่4.29 ประสิทธิภาพสูงสุดต่อเวลาการผสม  
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เวลาในการผสม(นาท)ี

ประสิทธิภาพสูงสุดต่อเวลาการผสม

การทดลอง
ครั้งที่ 

เวลา 
(นาที) 

พื้นที่ทั้งหมด 
(mm2) 

พื้นที่สีฟ้า 
(mm2) 

ประสิทธิภาพ 
การผสม 

1 1 84.33 44.615 47.09% 
2 2 84.33 24.186 71.13% 
3 3 84.33 8.923 89.41% 
4 4 84.33 3.922 95.35% 
5 5 84.33 0.797 99.05% 
6 10 84.33 0.618 99.26% 
7 15 84.33 0.226 99.73% 
8 20 84.33 0.536 99.36% 

ประสิทธิภาพสูงสุดการผสมเฉลี่ย 99.95% 
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 จากตารางที่ 4.4 ทำให้ทราบว่าไม่สามารถเพ่ิมสิทธิภาพของการผสมถึง 100% ซึ่งประสิทธิ 

ภาพสูงสุดประมาณ 98-99 % เวลาที่ใช้ในการผสม 15-20 นาที ถึงจะทำให้ผงผสมเข้ากันได้ จึง

กำหนดให้ค่าท่ีเหลือ 1-2 % เป็นค่าความคลาดเคลื่อน (Error) จะสรุปได้ว่า 

 - อัตราส่วนผสม 2% ใช้รอบในการหมุนประมาณ 40 รอบ ถึงทำให้ผงผสมเข้ากัน 

 - อัตราส่วนผสม 5% ใช้รอบในการหมุนประมาณ 200 รอบ ถึงทำให้ผงผสมเข้ากัน 

 - อัตราส่วนผสม 8% ใช้รอบในการหมุนประมาณ 300 รอบ ถึงทำให้ผงผสมเข้ากัน 
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บทที ่5 

สรุปผลและข้อเสนอแนะ 

5.1 สรุปผลโครงงาน  
 โครงงานนี้จัดทำขึ้นโดยมีวัตถุประสงค์เพ่ือศึกษาการทำงานของ เครื่องผสมผงวัสดุ V-
blender โดยศึกษาทฤษฎีวัสดุเชิงประกอบ กรรมวิธีการผสมผงและถังผสมรูปทรงตัววี มาใช้ในการ
ออกแบบในการสร้างเครื่องผสมผงวัสดุ V-blender ซึ่งได้เลือกเหล็กไร้สนิมหรือสแตนเลส 304 AISI 
ที่ทนต่อความเค้นและแรงกระทำ มาประยุกต์ใช้ในการออกแบบถังผสม ซึ่งทำให้ถังผสมสามารถทน
ต่อการกัดกร่อนต่อผงวัสดุที่ใช้ในการผสมได้ดี รวมไปถึงเพลาที่ใช้ในการส่งแรงในการหมุนของถังผสม 
เพ่ือให้อายุการใช้งานของเครื่องผสมใช้ได้ยาวนานที่สุด 
 เครื่องผสมผงวัสดุ V-blender ใช้โปรแกรม Solidworks มาช่วยในการออกแบบและการ
สร้างเครื่อง โดยอุปกรณ์หลักของเครื่องผสมผงวัสดุ V-blender จะมีมอเตอร์ไฟฟ้าขนาด 60 วัตต์ 
ความเร็วรอบสูงสุด 150 รอบ/นาที มอเตอร์จะส่งกำลังมาที่ล้อโซ่ด้วยอัตราทดที่ 3:1 ทำให้สามารถส่ง
กำลังด้วยความเร็วรอบสูงสุด 50 รอบ/นาที และภายนอกตัวเครื่องใช้แผ่นสแตนเลสปิดไว้เพ่ือความ
ปลอดภัยในการใช้งาน 
 จากการทดลองผสมผงของเครื่องผสมผงวัสดุ V-blender 1 ลิตร ประสิทธิภาพสูงสุดการ
ผสมเฉลี่ย 99.95% ใช้เวลา 5 นาที ความเร็วรอบสูงสุด 50 รอบ/นาที ที่อัตราส่วนผสม 8% ในการทำ
ให้ผงผสมเข้าด้วยกัน และจะได้ปริมาตรผงที่ผสมแล้ว 0.6 ลิตร/ครั้ง  
 
5.2 ปัญหาและอุปสรรค  
 1) สารทั้งสองชนิดมีสีเดียวกัน ทำให้ในการวิเคราะห์การเข้ากันของเนื้อสารเป็นไปได้ยาก 
 2) จากข้อ 1) ก่อนที่จะเริ่มทดลองผสมผงต้องนำผงที่ใช้ทดลองมาผสมสีก่อน ซึ่งคุณสมบัติ
ของผงพอลิเอทีลีนไม่สามารถเข้ากันกับน้ำได้ จึงจำเป็นต้องนำผงไปอบเพ่ือไล่ความชื้นออกจากผงและ
ให้ผงผสมเข้ากับเนื้อสีได้ 
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5.3 ข้อเสนอแนะ  
 1) ในการทดลองผสมผงควรใส่ผ้าปิดปาก แว่นตา หรือถุงมือ เพราะผงทั้งสองชนิดนั้น ถ้า
สัมผัสหรือสูดดมอาจจะทำให้ระคายเคืองได ้
 2) การเก็บผงทั้งสองชนิดควรเก็บในที่ภาชนะบรรจุที่ปิดมิดชิด และต้องไม่ควรเก็บผงไว้ในที่
เปียกและชื้น 
 3) ในการทดลองควรเป็นห้องที่มีอากาศถ่ายเทสะดวก 
 4) การติดตั้งของเครื่องผสมผงวัสดุ V-blender ควรวางที่โต๊ะท่ีมีความแข็งแรง 
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